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About this Course

This section explains the conventions used in the course and in this training
guide.
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Course objectives
Advanced Report Design is a classroom-based course where participants
learn use advanced querying and reporting techniques to create Web
Intelligence documents.The course includes presentation of concepts,
demonstration of features, facilitated discussions, practice activities, and
reviews.

After completing this course, you will be able to:

. Create Web lntelligence documents using advanced query techniques

. Apply character and date string functions

. Create variables using "lf. . . .Then. . .Else. ." logic

. Apply advanced reporting techniques using breaks, custom sorts and
functions

. Understand calculation contexts and how to redefine them

After completing this course, you will be able to:

Course audience
The target audience for this course is experienced Web Intelligence report
designers.

Prerequisite education
To be successful, learners who attend this course must have attended the
following offerings:
. BusinessObjects Web lntelligence Xl R1/R2: Report Design

Prerequisite knowledge/experience
To be successful, learners who attend this course must have working
knowledge of:
. Core concepts and functionality of Web Intelligence
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Course success factors
Your learning experience will be enhanced by:

. Activities that build on the life experiences o{ the learner

. Discussion that connects the training to real working environments

. Learners and instructor working as a team

. Active participation by all learners

Course materials
The materials included with the course materials are:

. Name card

. Learner's Guide
The Learner's Guide contains an agenda, learner materials, and practice
activities.

The Learner's Guide is designed to assist students who attend the
classroom-based course and outlines what learners can expect to achieve
by participating in this course.

. Evaluation form
At the conclusion of this course, provide feedback on the course content,
instructor, and facility through the evaluation process. Your comments will

assist us to improve future courses.

Additional information for the course is provided on the resource CD or as a
hard copy:

' Sample files
The sample files on the resource CD can include required files for the
course activities and/or supplemental content to the training guide.

. Overview webinar(s)
This webinar provides details about the course and an overview of the
course material.
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Additional resources include:
. Online Help and User's Guide

Retrieve information and find answers to questions using the Online Help
and/or User's Guide that are included with the product.

Learning process
Learning is an interactive process between the learners and the instructor. By
facilitating a cooperative environment, the instructor guides the learners
through the learning framework.

What's specific to BusinessObjects Xl Release 2?

tu*.a.* The.audience for this course may consist of BusinessObjects Xl Release 1 and-ffi" 
--_. BusinessObjects Xl Release 2 customers. This icon has been placed

,Nf f, , throughout the guide to identify features that are specific to BusinessObjects

= Xt ReLase 2.
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dffiqW Introduction

Why am I here? What's in it for me?

The learners will be clear about what they are getting out of each lesson.

Objectives

How do I achieve the outcome?

The learners will assimilate new concepts and how to apply the ideas
presented in the lesson. This step sets the groundwork for practice.

Practice

How do ldo it?

The learners will demonstrate their knowledge as well as their hands-on skills
through the activities.

Review

How did ldo?

The learners will have an opportunity to review what they have learned during
the lesson. Review reinforces why it is important to learn particular concepts
or skills.

@W Summary

Where have I been and where am I going?

The summary acts as a recap of the learning objectives and as a transition to
the next section.

Recommended education
This course is not part of a certification path.
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Computer Setup

This section lists the hardware and software setup requirements for trying the
activities on your own.
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Introduction
The purpose of this setup guide is to provide the information necessary to set
up your computer and ensure the necessary course files are installed if you
want to recreate the learning environment.

This document provides:

. Hardware and software requirements for Business Objects training

. Guidance for learners wishing to recreate the learning environment

xvi Advanced Report Design-Learner's Guide



Computer Setup

Hardware
tr The minimum hardware requirements are:

. P3 700MHz

. 512 MB RAM, 1 Gigabyte RAM recommended

. 5 Gigabytes available hard drive space

. CD ROM

Software
tr The software required for this course is:

Operating system (choose one):
. Microsoft Windows 2000 Data Center Server SP4
. Microsoft Windows 2000 Advanced Server SP4
. Microsoft Windows 2000 Server SP4
. Microsoft Windows 2003 Server
. Microsoft Windows 2003 Data Center Server
. Microsoft Windows 2003 Web Server
. Microsoft Windows 2003 Enterprise Edition Server
. Microsoft Windows XP (Unsupporled operating system but

suitable for classroom use only, not suitable for production
environment.)

System Database:
. Native-MySQL (installed with BusinessObjects Enterprise by default)

. MS SQL Server (choose one)

. MS SQL Server 2000 SP3a or higher

. ODBC-MS SOL Server 2000 SP3a or higher

" ODBC-MS SQL Server 7

Web Browser:
. lE 6.0 sP2

Web Server:
. Tomcat 5.0.27 with JDK 1.4.2 (installed with BusinessObjects

Enterprise by default)
. Microsoft llS (5.0 ISAPI and CGI or 6.0 ISAPI)

Applications:
. BusinessObjects Enterprise Professional (ensure you use Processor

licensing)
. Microsoft Office (version 2000 or newer)

. Microsoft Word

. Microsoft PowerPoint

. Microsoft Excel

. Microsoft Access (optional)

. Adobe Acrobat Reader
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tr Install software according to the instructions in this document. Prior to
installation, refer to lhe Platforms.fX document for the latest supported
systems. Platforms.txt can be found on the installation CD. You can also find
the most recent version of this document on the Business Objects support web
site: http://support.businessobjects.com.

To install required software
1 lnstall one of the operating systems indicated above.

2 lnstall Microsoft llS.

Note: lf you are installing Microsoft Windows 2000 Microsoft llS will be

included by default. lf you are installing Microsoft llS 6.0, be sure to
installASP.NET.

3 Install one of the MS SQL Server system databases indicated above.

4 Install Microsoft Office (version 2000 or newer). lf desired, install
Microsoft Access.

5 Follow the installation procedures listed in the installation guide of
B u s i n e ssObj ects Ente rp ri se.

Note: lt is preferred that the classroom is set up with stand-alone
installations, however, it is possible to install one server and have
all students connect to that server.

Please note: during the BusinessObjects Enterprise installation, ensure
that you select the following options:

. Server installation (not Client)

. New installation (not Expand or Custom)

. Select Java and .NET web installation, including Tomcat

WARNING: lf you opt to installthe .NET framework, there are
multiple activities in the course that will not be possible. This course
REQUIRES that the Java environment be installed.

Note: A prepackaged version of Tomcat with Apache web server is
provided during the BusinessObjects Enterprise Xl R2 installation.

6 Make sure that all of the computers in the training room can access the
same network and can communicate with one another over the TCP/IP
network.

Testing the hardware and software setup
To ensure the hardware and software are set up properly, perform these steps
on your machine.

To test networking of all machines
1 From the instructor's machine, run ipconfig using the command prompt.

2 lf it says media cable disconnected, check your hardware wiring and
make sure it is plugged into the room's network at a minimum.

3 From the command-line prompt, run ping <ip or machine name of a
student machine>.

4 lf it says "request timed out" then recheck hardware wiring and make
sure all machines are on the network.

5 lf you can ping all machines from one single machine and all computers
reply/respond then your network is fully functional.
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To test Central Management Console installation
1 From the BusinessObjects Xl Release 2 Program Group, click on

BusinessObiects Enterprise Java Administration LaunchPad'

2 Click on the link for the Central Management Console.

3 Log on as Administrator, no password.

Successful login indicates successful installation. Repeat steps 1-3 for

.NET Admin Launchoad.

To test lnfoView installation
1 From the BusinessObjects Xl Release 2 Program Group, click on

BusinessObjects Enterprise .NET InfoView.

2 Log on as Administrator, no password.

Successful login indicates successful installation.

3 Ensure that the report samples have been installed successfully by
navigating to any Public folder and opening an object.

For example, Report Samples > General Business > Open the Product

Catalog report.
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Setting up for the activities
The following setup needs to be completed prior to the instructor arriving on-
site. The universes below will be used during the classroom activities. The
following setup instructions are NOT part of the course and must be completed
prior to the course. lf the items below are not completed prior to the instructor
arriving on-site it WILL cause a delay in the delivery of the course and you may
be charged for the additional setup time required.

The directions below are step-by-step and can be followed with little
knowledge of the BusinessObjects Enterprise Xl development environment.

Upon completion of these items please conlact your on-site instructor to let
them know that the setup is complete.

Deployment of Universes

This course uses the followino universe:
o eFashion

This universe is installed by the Enterprise Setup program to the following
location:

C:\Program Files\Business Objects\BusinessObjects Enterprise
'l 1 .S\Samples\en\Universes

It is also available on the course resource CD. The corresponding Microsoft
Access database is also available on the course Resource CD.

In order to make the universe available to the users you must first redefine their
connections to the appropriate data source (Microsoft Access database file),
then export the universe to the repository.

Before doing this, you first need to ensure that a valid ODBC connection is

Dresent on the workstation.

The following instructions describe how to define a connection and export the
eFashion universe.

To create an ODBC connection:
I Click Start > Programs > Administrative Tools > Data Sources

(oDBC).

2 Click the System DSN tab.

Note: In order to deploy a universe, the connection to the data source must
use a system DSN.

IF THEN

A connection for eFashion alreadv exists Go to Step 3.

No connection for eFashion exists. Go to Step 10.
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Start here if an eFashion ODBC connection already exists.

3 Click eFashion.
4 Click Configure.
5 Click Select.

Note: The correct database may or may not be selected. lf a previous
version of BusinessObjects ever existed on the machine, the
connection may be left over from that version. Continue through
steps 5 - 8 to verify the correct database is selected. The eFashion
database in BusinessObjects Enterprise 11 is different than the
database in orevious versions.

6 Browse to the directory you installed BusinessObjects Enterprise 11 in
...\Business Objects\BusinessObjects Enterprise
1 1\Samples\En\Databases.

7 Select efashion.mdb. Click OK.

8 Click OK to close the ODBC Microsoft Access Setup window.

9 Click OK to accept the ODBC changes.

10 Skip to step 18.

Start here if a new eFashion ODBC connection is required.

11 Click Add.
12 Select Microsoft Access Driver (-.mdb). Click Finish.
13 Type eFashion as the Data Source Name.

14 Click Select.

15 Browse to the directory you installed BusinessObjects Enterprise Xl R2 in
. . .\Business Objects\BusinessObjects Enterprise
1 1 .S\Samples\En\Databases.

16 Select efashion.mdb. Click OK.

17 Click OK to close the ODBC Microsoft Access Setup window.

18 Click OK to accept the ODBC changes.

After creating / verifying the eFashion ODBC connection, continue to
the instructions below.

To define the connection in the unioerse
1 Click Start > Programs > BusinessObjects 11 > BusinessObjects

Enterprise > Designer. Log into BusinessObjects Designer. lf you are
using the default installation, you can use the username Administrator
with NO password.
lf the wizard opens, click Cancel.

2 Click File > Open.

3 Browse to the directory where BusinessObjects Enterprise Xl R2 was
installed
. . .\Business Objects\BusinessObjects Enterprise
1 1 .S\Samples\En\U niverses.

4 Click eFashion.
5 Click Open. The universe will open in Designer.

6 Click File > Parameters.

Computer Setup-Learner's Guide XXI



7 On the Definition tab, click on New to add a new connection.

Note: The connection must be a "secured" connection prior to publishing

to the repository.

I The New Connection Wizard appears. Click on Next.

9 Double-clickMicrosoft.

10 Double-click MS Access 2002. (Or the appropriate MS Access version)

11 Click ODBC Drivers. Click Next.

12 Verify the Type: is Secured.

13 Type Secured eFashion as the Name"

14 Select eFashion as the Data source name.
Your new connection window should look like this:
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15 Click Next.

16 Click Test Connection. Verify that the test was successful.

l{ you do not see the message The server is responding! Click the < Back
button and resolve the issue.
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17 Click Next.

18 Click Next.

19 Click Finish.
The secured eFashion connection is now shown.
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20 Click OK.

21 Click Tools > Check Integrity.
22 Check the check box for Check All.
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Click OK. The integrity check runs.

Verify that the Check lntegrity Results match exactly as shown below.
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25

26

Click OK to close the window.

Click File > Export.
The export universe window appears asking for confirmation of saving.

t he crrrer{ wt'erre *# be saved bdse bcrB c,qFodfd V/cdd,firu lta to cortrse?

-XJ

27

28

29

30

coriiare I N, I

Click Continue.

Select the Folder.

Select the Groups (leave default if you are not sure).

Click OK.
The Universe successfully exported message appears.

j,t x?

U rrer*a auec*r$r$ *.golt*d

31 Click OK.

32 Close BusinessObjects Designer.

Note: As stated previously, the eFashion sample universe and database are
located in this folder:

C :\Program Files\Business Objects\BusinessObjects Enterprise
11 .5\Samples\en\

Testing the hardware and software setup
After exporting the eFashion universe, follow the steps below to verify that all
files are in place for the training class.

Verify users can log into the fSP version of
BusinessObjects Enterprise XI R2

1 Click Stafi > Programs > BusinessObjects Xl Release 2>
BusinessObjects Enterprise > BusinessObjects Enterprise Java lnfoView

2 Log in as a valid user. lf running only the samples, log in as
Administrator. Administrator does not have a password.

Verify eFashion universe is available.

3 Click Web Intelligence Document from the New menu.
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4

5

6

7

Verify that eFashion is listed as an available universe.

Click eFashion to create a new Web lntelligence document'

lf the security warning appears, click Yes to trust the applet'

Double-click Year.

Double-click Sales Revenue (in the Measures class).

Click Run Query.
The results should match the image below.

9 Close the document without saving (click X in top right corner).
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Verify sample Crystal Report document is available.

10 Click + to expand Report Samples.

11 Click General Business.
Verify that the World Sales Report is listed.
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Click World Sales Report to open the report.

The report opens.
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13 Close the report.

14 Log out of BusinessObjects Enterprise.

The setup is now complete.

:). ....... ':;
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Getting Help
lf you encounter difficulties installing the software when recreating the learning

environment, refer to the Installation document found on the product CD or

conract Business Objects Customer Support. For a current contact list visit

http ://su pport. busi nessobjects. com.
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Lesson 1

Advanced Query Techniques

This lesson demonstrates how to use advanced query techniques.

In this lesson You will learn how to:

. Use combined queries

' Use sub-queries
. Create a query based on another query

Duration:1hour

Copyright O 2006 Business Objects. All rights reserved' 1-1



Use combined queries

"@W Introduction
In most instances, you only need to make one Web lntelligence query to
populate the data provider with the information you want to report on. However,

there are certain instances where you will need to make two or more querles

to retrieve the results you require. As a Web Intelligence user, there are two

techniques available that enable you to do this. They are;

" Combined queries

The combined queries technique enables you to create two queries and

merge the results of both into a single data provider on a selective basis'
This can be done by using the Union, Intersect, or Minus functions.

Note: In this unit, you will see that combining queries in a single data
provider is different from synchronizing multiple data providers

using merged dimensions, which was presented in the
BusinessObiects Web lntelligence Xl Rl/R2 Repoft Design
course.

. Sub-queries
The subquery technique enables you to specify the output of a query as

the operand value(s) for a query filter of another query.

This unit describes how to use combined queries.

After completing this unit, you will be able to:

. Describe the Union, Intersection and Minus functions used to combine
quenes

. Discuss reasons and advantages to using combined queries instead of

applying complex filters
. Create a combined query

" Remove a combined filter
. List important facts to remember when using combined queries

ffi

ru

W About combined query functions
Adding single and complex query filters to a query allows you to restrict the

amount of information returned by the query. This standard technique allows
you to combine multiple filters in a single query, and these combinations can

be designed to make queries very specific and limiting.

However, this technique only works with a single query. There may be

situations when you want to combine the results of two queries into a single

block.

To accomplish this, you must build a combined query. All combined queries are

built in the Edit Query view of the web Intelligence Java Report Panel, and can

only be built using a single universe. You can create up to eight queries from

the same universe; however, each query needs to have the same number of

objects as well as the same data types.
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There are three methods of combining queries:
. Union: combine results which appear in Query 1 OR euery 2.

You use a union query to combine the data from two objects in a single
column in a table. Union queries are especially useful for working with
incompatible objects.

For example, if you built a query with two incompatible objects, Web
Intelligence would run separate sQL statements for each object and then
return the data in different blocks (tables). A union query forces Web
Intelligence to return the data from both objects together in one column.

Note: Union is the default operator for combined queries.
. Intersection: combine results which appear in Query 1 AND euery 2.

You use an intersection query to obtain data common to two sets of
results. Like a union query, Web Intelligence considers each select
statement separately and combines their results in the end.

Unlike a union query, the intersection query only returns those values that
are in both queries. In this sense, it works much the same as using the
AND operator when creating a regular query with multiple query filters.

. Minus: combine results which include everything in Query I except for
what is also true in Querv 2.
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You use a minus query to exclude the results of one query from the main
query result (Query 1). For example, a minus query could be used to find
out which customers bought product A but not product B.

You could not obtain this data with standard query filters since the result
sets need to be obtained separately before being combined. Like a union
query, the minus query considers each query separately and combines
their results in the end.

When you build minus queries, you must pay attention to the order of the
queries, since the results of Query 2 will always be subtracted from the
results of Query 1"

Understanding when to use a combined
query
The following is a typical scenario where you might choose to use a combined
query:

You need to find the dates on which your customers either made reservations
or paid their invoices. The query requires two incompatible objects: Invoice
Date and Reservation Date. Since the objects are incompatible, if you include
them in a standard query, Web Intelligence returns two blocks of data and does
not synchronize the values in a single block. However, by building a combined
query using the Union function, with Invoice Date in the first query and
Reservation Date in the other, the data appears in a single column in the block.

The Union function is much the same as using the OR operator with a complex
query filter: it returns dates on which either invoices were paid OR reservations
were made.

However, the column of data retrieved by the combined query displays a
header that reflects the date object from the first query only. In other words, the
query returns a column entitled Invoice Date, but the column actually contains
both Invoice Dates and Reservation Dates. This is important to understand, as
it may require you to reformat the header.

\nr
/\3"

&tuq&f Advantages of using combined queries

There are a number of reasons why you may want to use combined queries
instead of applying multiple query filters against a single query:
. To make the construction of the query easier
. When it is not possible to set the required query filters using Boolean

logic

The downside of using the combined query technique is that because you are
actually creating multiple queries, processing against the database may take
longer.

Note: A decision on whether to use query filters or a combined query to
retrieve the data you need often depends on how the data is structured
in vour database.

1-4 Advanced Report Design-Learner's Guide



Comparing query filters and combined
queries

As an e-Fashion Regional Product Manager, you want to compare accessories
sold in California and those sold in Colorado.

To do this, you can use one of three techniques:

. You can create two separate queries and display the data in two different

blocks, either in the same report or in separate reports in the document.

. You can create a single query and apply a complex filter.

. You can combine two different queries into a single query.

The technique you choose depends largely on the data that you are working
with. However, using the combined query technique allows you the flexibility of
comparing the data in a single block, and in different ways, using the union,
intersection or minus function, depending on how you want to display the data.

To display the results by building tzoo queries

In this example, you build one query to show accessories sold in California,
and then a second query that shows accessories sold in Colorado. You display
the data in separate blocks in a single report.

1 Create a new Web Intelligence document using the eFashion universe.

2 In the Java Report Panel, build a query by dragging or double-clicking the
State and SKU desc objects to move them into the Result Objects pane.

3 Apply a query filter so that only data concerning California and the
Accessories oroduct line is retrieved.
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In the Edit Report view, apply a Break on the State column and a Count
to the Sku desc column in the resultino block.

itrawbeny Patlerned Viscose Scar{

Itriped Leqgings

Suede Belt with Heart Shaped Euckle

Suede Cloth Belt

Sunflower Patterned Viscose Scarl

Thick Silver Bangle

fhinsulate Knit Gloves

Tie-die Fatterned Viscose Scarf

Tortorseshell Brooch

Tulin Patterned Viscose Scarf

Two Color Dauble Sided Velvet Scad

Velvet Purse

Velvet Shoulder Baq

Zipper Vesl

California 75

You will find that there are 75 separate rows of product data in the table.

Note: The above image does not show all of the rows in the table.

Click Edit Query to return to Edit Query view and add a second query to
the same document.

In Edit Query view, click the Add Query button.
The Universe dialog box appears, which allows you to select the universe
you want to use for the new query.

I Select the eFashion universe.

1! s*ca i-i"i1:ru*rc qg1
4::t:

i $t*Kri*ir istlli ift ,t!;r de:res4${i 
= 

:
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1-6 Advanced Report Design-Learner's Guide



9 Build the same query, except change the query filter to retrieve data for
Colorado, instead of California.

. 
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Query 2.

Select the lnclude the result objects in the document without
generating a table option.

In Edit Reporl view, at the bottom of the Data tab, click the Arranged by:
Alphabetical order drop-down button.

Select the Query option from the drop-down menu that appears.
The objects listed in the Data tab now appear organized by query, instead
of in alphabetical order.

Click + next to the Query2 - eFashion folder to see the objects used in
your second query.

The Query2 - eFashion folder expands.

While holding down the Ctrl key, click both the State and SKU desc
objects in the Query2 - eFashion folder and drag them over to the empty
space next to the existing table.
The new table displays the results for Colorado.

11

12

13

14

15

t 'dl oueiy I - eFashion
: , 1 SKL|desc

- "l State

B &l Buery 2 ' eFashian

Fl ItAl Merged Dimensaons

- l![ Variebles

Advanced QuerV Techniques-Learner's Guide 1al- t



16 In the new table, apply a Break on the State column and a Count to the
Sku desc column in the second block.

iunflower Fatterned Viscose Scad

[hick Silver Bangle

[hinsulate Knit Gloves

[ie-die Fatterned Viscose Scad

[ortoiseshell Brooch

[ulip Patterned Viscose Scarf

lwo Color Double Sided Velvet Scarf

'/elvet Shoulder Baq

Iipper Vest

Colorado 57

Note: The above image does not show all of the rows in the table.

Notice that the new table shows that vou have sold 57 accessories in

Colorado.

To display the resultsby applying a complex query filter to a
single query

You can get the same result by building a single query, and applying a complex
query filter that specifies both California and Colorado in the query filter
definition. as shown here:

Rr$i ObisP i't r:t 2h ) |i)l i,rl ir;;: ::J
":! Stde ::l sKU #€

/ Srarn wlh hg @h9 nour
- iJoodw'

a Lmes E.;d,;h*d*--.- rnwq,;" - -

In the next section, you will see how using combined queries allows you to
analyze the commonalities and differences in the accessories sold across the
two states.
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W Using the combined query technique

The combined queries technique combines the results of one query with the

results of another query into a single query, or data provider. The manner that

the data is combined depends on the function you choose: Union, Minus or

Intersection.

To combine queries
1 ln the Java Report Panel, click the New Document button to create a

new document using the same universe.

2 ln Edit Query view, drag or double-click the SKU desc object to the

I qt Result Objects pane.
twli-rj g Click the Combined Queries button.

A new pane opens in the Edit Query view, just below the Classes and
Objects pane.

liI;€ ?lmo*r t.niq::r.r: Iid$
0da i rr p' rr-.
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1 SKIJ fu

Untdeisrpum IsKUJ LoMsi level ol prodrct descnptm EDch troduct coftr rn.evsd d'lermt mlcs

This pane allows you to define how you want to combine the queries that
will be included in this single data provider. Note that the Combined
Query 2 label in this pane is highlighted and the Result Objects pane is
currently showing the query definition for Combined Query 2.

In the Combined Query pane, click the Combined Query 1 labelto
display its query definition.
The Combined Query'1 definition appears in the Result Objects pane.

Advanced Query Techniques-Learner's Guide 1-9



Insert the query filters illustrated in this example in the Query Filters pane
of Combined Query 1.

F-
irul*n,,:,,t.luLiiU**ri

Glick the Combined Query 2 label, and then apply the query filter as
illustrated in this example:

By default, the system applies a Union function between Query 1 and
Query 2, as shown in the Combined Queries pane.

You can change the function double-clicking Union in the Combined
Queries pane. This toggles the function to lntersection.

1-10

.G:: rire Fiod
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Double-clicking the function once again toggles it to Minus.

In this instance, you want to use the default function, the union function.

Click Run Query.

Apply a count to the single column of data.

Suede Clolh Belt

iunflower Fatterned Viscose Scarf

Thick Silver Banqle

Thinsulale Knit Gloves

Tie-die Fatterned Viscose Scarf

Tortoiseshell Brooch

Tulip Patlerned Viscose Scarf

lwo Color Double Sided Velvet Scarf
y'elvet Purse

/elvet Shoulder Baq

lipner Vesl
f5

Notice there are 75 Accessories in your list. These are the ones that were

sold in either California or Colorado.

Note: The above image does not show all of the rows in the table'

I Edit the query so that it uses the Intersection function to combine the

two query definitions.

7

8
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10 Click Run Query.

Spolty Leggings

Squere.Viscose Sample

Striped Leggings

iuede Bell with Heart Shaned Buckle

iunflower Patterned Viscose Scarl

fhick Silver Eanqle

lhinsulate Knil Gloves

lie-die Patlerned Viscose Scaf
[orloiseshell Brooch

lulin Patterned Viscose Scad

Two Color Double Sided Vehet Scarf
y'el€t Shoulder Bao

Doer Vest

57

Notice there are 57 accessories in the new list. These are the ones that
were sold in both California and Colorado.

Note: The above image does not show all of the rows in the table.

11 Edit the query so that it uses the Minus function as its combined query
technique.
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Prompt Order

12 In the Query Properties tab, clear the Retrieve duplicate rows box'

A}bh

iA_*-'j
13 Click Run Query.

Notice there are 18 accessories in the new list. These are the ones that
were sold in California, excluding those that were nof sold in Colorado.

Chain and Pearl Necklace

Diamond Slar Earings

0oldset Pearl Necklace

Hair Clip

Jacquard Scad

Large Rose Pgtl€rned Visc0se Scatt

Large SilYer Bratelet

Pastel Colored Vrscose Scaf

Rigid Twisled Knot Bracelel

Shell Headband

Silver Hoop Earflngs

$nake LBop Nerldace

Slrawberry Patterned Viscose Staf

Suede Cloth Bell

Velvel Purse

1B

Note: The above image does not show all of the rows in the table'

14 Save this document to your Favorites folder as Combined Query.
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To remoae the combined query
1 In Edit Query view, right-click either the Combined Query 'l label or the

Combined Query 2 label.

2 Select Remove from the drop-down menu.

The query definition you highlighted is deleted. Whichever query
definition you did not right-click will remain in the Result Objects and
Query Filters pane.
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ffiW Important facts about combined queries

Below are some important facts to keep in mind when you use combined
queries:

. Queries that you combine must contain the same number of objects in

order to return the same number of columns of data.
. When you build a combined query to return data from more than one

object in a column, for example, using the union operator, you must use
objects of the same type (character, date or number).

. Only the objects placed in the first query are displayed in the block after
the query is run. Any object used in a combined query does not display in

its own column, but instead, the values are returned in the same column
as the object from the first query.

. Web lntelligence's default behavior when combining queries is to perform
a Union (not a UNION ALL), and to return all values less the duplicates.

. You can include up to eight queries in a combined query.
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W Practice

Activity: Combined queries

Objectives
Create a Web lntelligence document by combing queries, using the Union,
Intersection and Minus functions.

Instructions
You are interested in reporting on the relationship between the eFashion
stores that earned at least $3,000,000 in sales revenue and those stores
whose margin was at least $1,300,000.

Assume that you already have two reports built using the following queries:

Report 1:l

e-Fashron Chrcago 33rd $3,0?2,65S

e-FashlonHoustonLerghto $3,144,774

e-Fashton LBs Angeles $4,22[,S?S

e-Fashron New York M3ono $4,621.854

e-FashLonsanFrancisc0 $3,258,641

5

+Fashion Los AngBles $|,668,3s5

e-Fashi0n New York l\4agn0lia $1.870,868

e-Fashi0ft San Francisro $1,304,51 5

3

Using the combined query technique, create the following reports:

1 Create a table showing all Store names that have had both Sales
Revenue of $3,000,000 or higher @! a margin of $1,300,000 or higher.

. Which operator will you use to combine the queries?

-l Slore name o} Snles revenue

* Snles revenu€ GreatEr thanor Equd tq -

Report 2:l

J Mdgin Grsdtr than d Ewd to -
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Once you run the combined query, apply a Gount to the Store name

column.
The table should appear like this:

e-Fashion Los Angeles

e-Fashlon Neu York tulagno'la

e-Fashion San Francisco 
J

3 Edit the query and update the data in the table so that it shows all store

names that have had Sales revenue of at least $3,000'000 but @La
margin of $1,300,000 or more.

. Which operator will you use to combine the queries?

4 once you run the combined query, check that the count is still applied to

the Store name column.

The table should appear like this:

e-Fashion Chicago 33rd

e-Fashion Houston Leighton

?

Edit the query to display all store names that have had either Sales

revenue of ai least $3,000,000 9g a margin of at least $1,300'000'

. Which operator will you use to combine the queries?

once you run the combined query, check that the count is still applied to

the Store name column.

The table should appear like this:

e-Fashitrn DhitagD 33rd

e-Fashion Houslsn Leighton

e-Fashion Los Anqeles

e-Fashi0n l'ie${ York lLiaqn0lla

e-Fashion 5an FrantisIo

5

SavethedocumentInyourFavoritesfo|derasAct-Combinedqueries.
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Use sub-queries

}ffi

rrt
x,',*

.r#h'
W,t Understanding sub-queries

Sub-queries are used in cases where the results of the main query are
dependent upon the results of the inner query. This means that the inner query
must be processed first so that the result set can be passed on the main query.

Like combined queries, sub-queries are always built in the Edit Query view of
the Java Report Panel.

You construct a sub-query by placing a query filter on one of the objects in the
main query and then using the operand for that query filter to launch the sub-
query. The operator you include in the query filter determines the relationship
between the data sets returned by the inner and outer queries.

Typically you use sub-queries when:
. The value of the operand is unknown.
. The query filter for the report involves a value that will change over time.

W lntroduction
A sub-query, as its name suggests, is a query within a query. lt contains an
inner query, which returns a set of data that is used as the basis for a second,
outer (or main) query.

After completing this unit, you will be able to:
. Describe sub-queries
. Create a sub-query

rto*r gratrJ: ilmoh arNi
$a ny sto* {Chice6o 5tuill?

A ruf,-qucry wilt do O.+
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W Creating a sub-query
Using this scenario, you willexplore how and when to use sub-queries.

You have been asked by the Manager of the Chicago 33rd store of the
eFashion Group to produce a report that lists stores and their revenue
whenever those stores' revenue are higher than Chicago 33rd.

To produce the requested revenue report, you need to resolve one issue
regarding the query filter. The query filter for the re,port involves a value that is
not known prior to a query being made, and it will change over time. Therefore,
you cannot enter a hard-coded figure for the sales revenue for Chicago 33rd
because the user would never be able to re{resh the report and get accurate
results.

You can resolve this using a sub-query.

To apply a sub-query 6s part of a query
1 Create a new document using the eFashion universe.

2 In the Java Report Panel, drag or double-click the Store name and Sales
revenue objects to move them to the Result Objects pane.

3 Click the Add a subquery button.
The Edit Query view appears like this:

f.lts,4$&.*d'is,sqp,,F.ti#$$$,ttl t||,. \,tj:a*:
i : 4:i.* . ei if,!91 9;e:i 9:11ry1

',.-. ...,,.. ;'fi'6t,.x.
gFwo€ry A :6 $;i .

:4 I € I Bi*a ousy r !:- I i:i* 'af,, ,P I s*
iDdatR{e!.'

+ g rmFroo
Be*0!c*

fSbergm JSabarernueE:l Sror.

a State

I Clt
i: f Sloren6he

* Zipcde
4 Addei5

t: tiJ srde derat.
'f Sabll@t na?
/ 0Med sto'cs

f sliler wlh long w
+i 

'41 
Producl

i. dEl Romoltrs
:: ,i2 Measurerr@

. ! oudly sold

t5*rreven€ $ $re€nue ol Slii.l sold

1.... ........:,.....

By default, the Sales revenue object appears in the sub-query definition.
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5

6

7

8

Replace the default In List operand with the Greater than or Equal
ooerano.
The Query Filters pane appears like this:

{tr, ,r s*o o"€@ 61"d1muo..L1i4.fo 
';,=o,,a,,,_ 

,*rn*'*1n 
:

',':t.:t.,:jtlj,t!:.1:;,:r,!-,t.ti:t::.',raij:,i1.., li,rjL:liliri;r:'t:t::!:t:il'r9iirri:.l't
tt t ;i1.rj i..)'.!t \1, i,:11:);: :')\i;tr'i i.llt::.

:

There are two sub-query operand types: All and Any.

n The All option means that the query filter object will be compared to

all values resulting from the sub-query.

. The Any option means that the system will only look for one instance

of a value from the sub-query that meets the query filter. lf it finds

one, it then ceases the comparison with the remainder of the sub-

query output. Obviously, the difference between the two only matters

if there is more than one value output by the sub-query' In this
instance, that is not the case.

Leave the sub-query option to the default value, All.

To define the sub-query, drag the Store name object into the sub-query

zone just below the query filter definition.

The Query Filters pane appears like this:

Replace the default ln List operand with Equal to.

Click the drop-down list arrow next to the Type a constant field.
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10

From the drop-down menu that appears, select Value(s) from list.
The List of Values dialog box appears:

Boston Newhrry
Chieqo 33rd
Cdsado Springs
Dallas
Houston sth
Hru*on Lellton
Los Angeles
MiamiSunddrcr
New York M€rclia
Nw Yuk Surdance
5an Francisco
Washington Tobooth

From the List of Values dialog box, double-click the eFashion Chicago
33rd store name and click OK.
The Query Filters pane appears like this:

i P o Sahr rryru Gleder thtr d Eq.ld bo .
i i' ' ."1. - :::..: j.; i

ii"1,-,'
i!

i
:

.9;r*..j.*;ffi;. 'tit!:

Click Run Query to process the query.

The table block displays.

12 Save the document as Doc_Revenuereport.

Note: Sub-queries involve complicated SQL and can take a long time to
process. Almost all sub-queries will take longer to process than a
standard query.

11

$3,144,774

ashion New York M
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W Practice

Activity: Using sub-queries

Objectives
Create a sub-query using the results of one query as the starting point for a
secono query.

Instructions
You have been asked by the Manager of the Colorado Springs store of the
eFashion Group to produce a report that lists stores and their revenue where
they are higher than Colorado Springs.

1 Using the eFashion universe, create a new document and build a query
using Store name and Sales Revenue.

2 Using the sub-query technique, return those stores with a higher revenue
than the Colorado Springs store.

3 You also need to display a title.

4 Save the report as Act_Subqueries.
5 The report should look like this:

Stores with a Revenue Higher than Colorado Springs

e-Fashion Chicaqo 33rd

e-Fashion Houston 5th

e-Fashion Houslon Leiqhton $3 ,1 44 ,774

e-Fashion Los Angeles

e-Fashion New York Maqnolia

e-Fashron l''.lew York Sundarrce

e-Fashion San Francisco $3 ,?58 ,641

e-Fashion Washinuton Tolbooth
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Create a query based on another query

ffi.W Introduction
Web Intelligence enables you to base one query on the structure of another
Creating a query on a query can save time with complex reports and can
ensure that different queries are defined in exactly the same way.

After completing this unit, you will be able to:
. Duplicate a query in a document to build another query

W Basing a query on the structure of another

To duplicate a query in order to build another
1 Using the eFashion universe, create a new document in the Java Report

Panel.

2 Drag or double-click the State, Year and Sales Revenue objects to move
them into the Result Objects pane.

3 Apply a prompted query filter so that you must select a state every time
the document is opened or refreshed.
The Edit Query view appears like this:

t: ...,. ..-..........1.Dd it
*,aunouerv *i:i 6l 17 '

Dda llr'sFii.,:i .,:

:'"*":t
a Thrle.r
I (hd:im.3 Ferod

, Ho'idat Pe'Ed
- d Sro,-

obi*

f, StalE -1 Yeor J 5ds rerrm

t@
a Cilr

:t a St.renefrP
ri tlt Sr.redeta,L

I Sales iloof.Ee?

l" ldned store!

f Storet w(h bng openrn! hout
t ral Protuct

- *rt PDm9ions

" 
sde. revenue

J 0cnrry sold

J lidrqrl

" 
or..Dunl

,t P:rolia'i ,,::' t,i-"d
90wry1

4 Run the query and select New York.
Your report should look like this example:

Now you will set up your second report block based on the query
definition used to create the first block.

5 Click Edit Query.

f sr6te Equd to - l!!!f!q. i

New I ork

$1,151,1122
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In the Edit Query view, right-click the Query 1 tab at the bottom of the
Data tab.

From the drop-down menu, select Duplicate Query.
A second query appears in the Edit Query view, and its tab is labelled
Query 1 (1), which indicates that it is an exact copy of Query 1.

't.r.,.,S'J;f- B,* -i$Fmoc'ie . #
ffii8r ?lAddoFe: ',: )V:.!tt pirR.

oda L:firffirirl

-:l gt eFashbn

= 
,it Im Pd
F: 1 Yed

: a 0uanet

ri: a Montl

, "1 Holday Leh]

I f chisas Fid
- I Holdd! Frod

jtii t*l Sto'e

ii: Ue Proilcr
j: rClPrM

' 
ilg Measue!

u94ry ,, "

il SHe -f Yea a SdB rryne

", srde t@lb , r.r.i i.e jcJ .i:

I

i

I
9

10

11

12

13

:i:' :i ,: :=l ::=:',4:t'|'*
Ltsd RehB$ D6te. Jea), 4, mBE 4 2538 PM

You can now edit the second query however you wish.

Replace the State object with the Store name object.

Click the drop-down arrow next to the Run Queries button.

Select Query 1 (1).

Select New York.

Select the Insert a table in the current report option and click OK.

The new table appears below the previous one.

Using drag and drop, move the new table so that it is positioned beside
the existing one.

WEWWW
209'l

2002

2003 $3.1 51 .0??

$1,667,6S6

$?,763,503

e-Fashion NewYork sth

s-Fashion New York 5th

e-Fashion NewYork sth

E-Fashion New York Magnolia

e-Fashion NewYsrk Magnolia

e-F ashion New York t\'la gnolia

2001

2802

2003

2001

?002

2003

$644,635

$ 1 ,076,1 44

$1,239,5e7

$1,023,061

$1 ,687,35S

$1,S1 1,434
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Lesson summary

,sW Review

Quiz: Advanced Query Techniques
1 What are the three types of query techniques used in this lesson?

2 lf you were to use the UNION operator to combine queries, what would
be the result?

3 lf you were to use the INTERSECTION operator to combine queries,
what would be the result?

4 lf you were to use the MINUS operator to combine queries, what would
be the result?

5 Give an example of why a query filter won't return data when a combined
query using the MINUS does?

6 Can you do a sub-query and return exactly the same results as a
combined query?

7 Why would you choose to do a combined query rather than a sub-query?
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@ summary

After completing this lesson, you are now able to:

' Describe the union, Intersection and Minus func-tions used to combine
queries

' Discuss reasons and advantages to using combined queries instead of
applying complex filters

. Create a combined query

. Remove a combined filter

' List important facts to remember when using combined queries
. Describe sub-queries
. Create a sub-query
. Duplicate a query in a document to build another query
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Lesson 2

Character and Date String
Functions

The ability to create formulas and define them as variables in Web lntelligence
offers the report designer a very powerful tool. Variables act just like dimension
or measure objects. Once you have created a variable, you can use it throughout
the document to display data that you cannot retrieve by using the existing
objects in the universe.

In this lesson, you learn about some of the formula functions available for
manipulating character and date variables. While the syntax may take some time
to comprehend, it is well worth the effort as variables can provide you with more
flexibility in reporting.

Note: For more information about creating formulas and defining them as
variables, refer to the EusrnessObjects Web lntelligence Xl R2/R2 Report
Design course.

ln this lesson, you will learn about:
. Character strings
. Using the ReplaceQ function
. Using the Right0 function
. Using the SubString0 function
. Using the PosO function
. Concatenating different character strings
. Using date functions

Duration: t hour 30 minutes

Copyright @ 2006 Business Objects. All rights reserved. 2-1



Character strings

rffiW Introduction
A character string is a series of characters that form either a piece of text or
the individual values of a character-type variable. They are always categorized
as dimension objects, but the reverse is not true. A dimension object can be of
character, date, or numeric type.

Using Web Intelligence character-string functions, you can replace, modify, or
remove either all or part of a character string.

After completing this unit, you will be able to:

n Describe the character-string functions presented in this lesson

'W About character-string functions

The character-string functions presented in this lesson are:
. Replace - used to replace a specified string with another string
. Right - used to extract a given number of characters from the right
. Left - used to extract a given number of characters from the left

. SubStr - used to extract a string of variable length and position

. Length - used to identify the length of a string

. Pos - used to identify the position of a character in a string

Replace, Right, and Left are only useful when you want to manipulate a
constant string or a constant number of characters. SubStr is a more powerful
function. You will use the SubStr function to extract strings where the length
and oosition are not consistent.

@ Using functions in formulas and variables

You use the functions presented in this lesson when you are creating a
formula. You can create a formula either by typing it in the Formula bar (in Edit
Report view), or in the Formula Editor. Either method calculates the data and
displays the resulting values in the column that you have highlighted in the
block.

In this case, the formula will be used only to display the calculated data in the
highlighted column or row.

lf you want to use the formula repeatedly in different blocks or different reports
in the document, or if you want to identify the formula as though it were an
object in the document, you can define it as a variable.
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Using the Replace0 function

rffirqgt Introduction
The Replace0 function replaces a specified string with another string.

The syntax for the replace function is:

Replace([object] ; "o1d string', ;.,new stnjng',)
String refers to the string from which the substring is to be extracted. This is
normally the name of an object (for example, [euarter]).
Old string defines the character string to be replaced.

New string refers to the character string that replaces the old string.

After completing this unit, you will be able to:
. Use the ReplaceQ function to replace,,e" with the word ,,euarte/'

W Replace a substring

Q1

a2

G3

o4

2002

Example
You have a requirement to report on quarters using the word euarter instead
of Q in the reports. Use the ReptaceQ function to do this.

To replace a substring
1 Using the eFashion universe, create a new web Intelligence document.
2 Build a query in the Java Report panel using the year, euarter, and

Sales Revenue objects.

3 Click Run Query.
4 In Edit Report view, right-click the year column and select the set as

Section option from the drop-down menu.
5 Format the report so it looks like this example:

2001

$2,660,700

$?,27S 003

$1 ,367,841

$ 1 ,788,580

a1

a2

o3

a4

$3,3?6,1 72

$2,840,651

$?,87S,303

$4,1 88.1 ?0
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On the Reporting toolbar, click the Variable Editor button.

The Variable Editor dialog box appears.

ln the Variable Definition zone, enter a name for the variable you are

creating. In this example, type Quarters.

Verify that the variable qualification is deJined as a dimension'

Using the Data, Functions and Operators tabs, enter the following

formula in the Formula zone:

=Rep l ace ( [Qua rter] ; "0" ; "Qua rten " )

where:

complete the formula
Enter the Replace function in the Formula zone.

To do this, you can either:

1 Click the Operators tab and double-click the = operator.

2 Click the Functions tab, scroll down the list and double-click the

Replace function.
Or

To
1

Syntax Description

lQuarted the name of the object that retrieves the data

'o" the value stored in the database, followed by 1 through
4 to indicate the {irst through fourth quarters of the year

"Quarter " the character string that will replace "Q" in every
instance.

Note: Be sure to add a space after the word Quarter
and before the end-quote.
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1 Double-click the Replace function so that the function appears in the
Formula zone, automatically preceded by the = operator.

Note: Remember that you always begin a formula with the equal (=) sign'

As soon as you enter a function in the Formula zone, a description
appears in the bottom zone of the Variable Editor that provides the syntax
required for the function that you have selected.

Note that the syntax indicates you must use the semi-colon (;) character
to separate the strings in the formula.

i -f. Median

- f' Min

1...-f- Mod

i .A Month
i- fi, MonthNumber0ffear

r. fi MonthsBetreen
1..... fi. Name0f

i - -fx NoFiltel

- E Numbe0tDataProviders

r.--fl Number0fPages

:-'fi Nmber0lBows
i. f, odd

!.. fi Paqe

'- F' Percentage

; -fl Percentile

:.- f. Fos

i -f. Powt
.- fI Previous

' it UUaIter

i- A n*H
-'f' HelativeDate

ia@
i- fi FeportFilter

lJ

Click the More on this function link to get help on using this function.
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4

A Help window appears that displays a description of the function, the
syntax required to use the formula and an example of how it can be used.

Descrirtion

Replaces part of a string with another slring

Fuclion Group

Character

slrntax

ru1n,J Replace(rtling input_5lr1ng: stling srring_go_reFlace: slring replace_01t-h)

|nB|r

upuE_crring The input string

sEling_lo_replace The stflng within upur_icr1trgto be replaced

replaee_sittr The string t0 replace sirug_to_reFlace with

olltptn

The string with the part replaced

Exmple
Repla.e ( "llenr toRH" ; "oFtr" ; "ork" J relurns "New Y0rl('

Other Chaacter Functions

L:t:!:

. ai- udE GEi;aiifr;ffi

Click the Close icon to close this Help window.

Make sure that your cursor is still positioned between the open and close
parentheses that follow Replace, in the formula.

Click the Data tab then double-click the Quarter obiect.
The Quarter object appears in the formula.

Complete the formula using the appropriate character strings, as shown
here:

Click the Validate button in the Formula zone, to validate that vou have
used the correct syntax.

i=Feplacellouailerl t '0' "0uailer ")rl
i':l
:l!1
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lf the syntax is correct, click OK to close the Variable Editor.

The new variable now appears in the list of objects and variables in the
Edit Report view Data trab.

To display the data calculatedby the new oariable in the
table
1 From the Data tab, drag Quarters to the table and drop it over the

Quarter column, to replace that column with the new variable.
The table now appears like this:

iQu?ner 1

:8uafter 2

lQuarter 3

ralgrtgl1

2ffi2

s2r060J0q

$2r?q093

r$1361,84:!

$1,788.580

83,9?.6:'t72

$2,840,851

€uarter 3

Ouaner 4 $4,1 86,1 20

2 Save this document in your Favorites folder as Doc_Functions.

iOuarier 1t'
iSuader 2

'-M ourts
i--,9 osilds
:-* Yea
.-- il Sds rffiue
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Using the Right0 function

@ Introduction
The Right0 function is used to extract a fixed number of characters starting
from the right end of the character string.

The syntax for the Right0 function is:

Right( [object] ; number)

String refers to the string from which the substring is to be extracted. This is
normally the name of an object (for example, [Year]).

Number sets the number of characters to be extracted from the rioht of the
totalstring length.

After completing this unit, you will be abte to;
. Use the Right$ function to delete characters from a character string

ffi How to extract a substring using the Right0w function

Example
The Year object in the eFashion universe is formatted to return the year as a
four-digit number (for example, 2001). However, in our example report you
need to display the year in two digit format (for example, 01). To do this, use
the Right$ character string function.

To use the Right} function
1 Continue using the Doc_Functions.rep document in the Java Report

Panel.

2 In Edit Report view, click the Variable Editor button on the Report
toolbar.
The Variable Editor dialog box appears.
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In the Variable Definition zone, enter a name for the variable you are
creating. In this example, type Years.

Verify that the variable qualification is defined as a dimension.

Using the Data, Functions and Operators tabs, enter the following
formula in the Formula zone:

=Ri ghl( [Year] ; 2)

where:

The Formula zone should appear like this:

Click the Validate button in the Formula zone, to validate that you have
used the correct syntax.

lf the syntax is correct, click OK to close the Variable Editor.

The new variable now appears in the list of variables in the Variables
folder on the Data tab.

4

5

Syntax Description

[Year] The name of the object that retrieves the data

2 The number of characters to be extracted to the right of
the character string
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Drag the variable to the block and drop it in the desired position.

In this instance, swap the Year section header with the new variable

Years.

01

oultell
Ouafier 2

GugrJer 3

Ougrter 4

02

$3rF€or7oo

$212I9,003

$'1r387,841

$1,788,580

9lart€l t

Suarter 2

aultel.3

Quaiter 4

$3r3?A-1 72

$?,840,651

-q.z 
8I9:lr3

$4,1 86,1 ?0

Note: The Left character string function works in exactly the same way

except that the function returns the specified number of characters
starting from the left as opposed to the right.

Save the document.
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Using the SubString0 function

W Introduction

The SubString0 function extracts a specified character string from within a
string.

The syntax for the SubstrQ function is:

Subsrr( [object] ; posi ti on ; number )

String is the string from which the substring is to be extracted. This is normally
the name of an object (for example, [Store name]).

Position is the position of the first character in the string to be extracted (for
example, 1).

Number is the number of characters (from the initial position forward) to be
extracted.

After completing this unit, you will be able to:
. Use the SubString0 function to extract a character string from within a

string

ffi& How to extract a string using the SubString0w function

Example
The Store name object in the eFashion universe returns the name of each
store in the company, but prefaces each one with "e-Fashion." You want to
remove the "e-Fashion" portion of the character string.

This presents a challenge since the length of each store's name is different,
with or without the'e-Fashion' portion. Neither the RightQ or Left() functions will
work here,

The easiest wav to achieve the removal is to use the SubStr0 function.

Character and Date Strino Functions-Learner's Guide z-tl



To use the SubStr) function
1 Using the eFashion universe, create a new Web Intelligence document.

2 Build a query in the Java Report Panel using the State, Store name,
Quantity sold, Sales revenue and Margin objects.

3 Click Run Query.

4 Open the Variable Editor and create a new variable called Store.

5 Inside the Formula zone of the Variable Editor, use the SubStrQ function
to force this new variable to return ONLY the store names without the 'e-
Fashion' preface.

Consider the syntax:

=SubStr( [object]; beginning numben ;number of charactens)

For our scenario, enter:

=SubStr( [Store name] ; 11 ; Length( [Store name] ) )

why?
. "11" represents the starting point at which the formula is to start

displaying characters. This was established by counting the number
of characters in "e-Fashion" (9) and then adding a character to
account for the space between the word "e-Fashion" and each store
name (10).

. The Length0 function represents the number of characters you want
returned from the string. The object name (Store name, in this case)
determines the length of the string, so if you take the beginning
number (11 in this case) from the length of the string, you are
instructing the system to return all but the first 11 characters.

Note: Do not forget that the beginning number in the SubStrQ function is
the beginning character position that you want the substring to
start displaying characters. Character positions identified in the
SubStrfl syntax are those you want to see displayed, not those you
want to remove.

Replace the Store name column in the table with the new Store variable
so that your table looks like this example:

Save the document in your Favorites folder as
Doc_Margi nperformance.

26,244 $4,220,S29 $1,668,395

1S,8:0 $J,:5e,641 11,30d,515

t:,i6r $2,060,?75 $808,1 4S

1 11,744 $? 961 ,S50 $1 ,1 53,001

11 ,267 $1 ,87S,1 58 $77r,28 1

1 i,976 $3,022,65e $r,t54,093

7,616 $1 ,283,70T $51 1,684

'I 8,094 S:,960,36r |l.r,201,876

?8,264 $4,811,854 $1,87i_1,868

1 i,0i8 $:,69s,Eir $1 ,060,31 rl

1 1,365 S1,970,034 $754,861

1 3,8 1 6 $:,303,1 83 $S3S,2!E

1 B,SB8 $3,1 44,774 $ t ,28:,680

California

California

Dolorsdo

DC

Florida

lllinr:ris

MassaDhusettB

Nprr' York

New York

TexaE

Texas

Teras

Texss

Los Angeles

gan FranIisco

Colorad6 9prings

Washingtrln TDlbnoth

[4iami Sundanre

Chicago 33rd

BostBn Newhury

l\lew Y Drk 5th

New York l!1a!lnolig

Austin

Dallas

HOUSto|l

HBuston Leiqhton
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Using the PosO function

W Introduction
The Pos function returns the number of characters from the start of a string to
a specified character.

The syntax for this function is:

Pos([object] ; "search string")
Search defines the string to be searched for the occurrence of a character and
it's position in the string. This is often the name of an object (for example,

[Store name]).

Object is the character string you wish to search for.

After completing this unit, you will be able to:

. Use the Pos0 function to return only certain characters from the start of a
string to a specified character

)ffi

@ How to use the Pos0 function

Example

Now you want to display only the street names of each of the eFashion stores.
The Address object from the universe returns both the building number and the
street name. Therefore, a substring must be created to return only the portion
that is needed.

To use the Pos} function
1 Continue using the Doc_Marginperformance document.

2 Click Edit Query in the Java Report Panel and edit the query to add the
Address detail object.

3 Click Run Query.

4 In Edit Report view, drag the Address object from the Data tab to insert a
new column in the table, to the right of the Store column.
The address of each store is inserted in a new column.

Notice that there is a space after each building number. lf the formula
recognized at what position the space lies for each value, it could use
that position as a starting point for the SubStrQ function.

The PosQ function enables you to determine where the space sits and
therefore where to begin the substring.

5 Click the Variable Editor button on the Report toolbar to create a new
variable.

6 Name the new variable Space.
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ln the Formula zone of the Variable Editor, use the Pos$ function to

locate the position of the space in each address.

Syntax: =Pos([Address] ; " ")

#o*u fr runcl,l; tf }1ll?:* ,-Vad$leDefidtim-- *- I "-
-

.fr@.@:

0wwcdior: f-gfS;L -=-----:l
a Montfr
-'l State
-l Stote
-l Store name
-'l I'eat
} EEE
J Marqn

il Quantiiy sold

.l Sales revenue

l ypFl

X ..1

=SubstrllAddrelsj :PodlAddressl j ]+l GnqttiiFdd'essf ]]

]'l.t-:
i+;rri,aa;l 

r 
- 

i

ii.,:

8

I

, 
Dercri*im-

i€l*" -
oK | *T1 | ,, rrere {

Validate the syntax and click OK.

Add another new variable using the Variable Editor, called Store
Address.

Build this new variable to return only the street name of the store's

location. Use a combination of the SubStrQ function and the new Space

object.
The syntax should be as follows:

=SubStr([Address] ; ISpace]+1 ; Length([Address]))

You can also use:

10

why?
. The Space object sits at the 'beginning number' slot of the SubStr0

function's syntax. lt contains the variable name and the text pattern

you want to locate (a space in this case).

. The +1 tells the function to begin the substring at one position more

than the location of the space so that the space is not returned'

. The Length0 function instructs the system that the number of

characters to be displayed from each Address string is equal to the

length of each address after the character (a space in this case) in

the beginning number Position.
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11 Replace the old Address column with the new Store Address variable
so that the table looks like this example:

California .,
:Califomia

Cqlorag.o - ,,

;Flodda . -

,lllinois

tHas_sacllgl-ets
;Ne*York

New-I-ot _
:Teras

rqig
Texas

Texas

!-o€Alsele: ..,--.... j

San Francisco 
:

Colorado gprings 
:

Washington Tolbooth l

Millni gun-dan9?- . .

Chicago 33rd

Boslol Ne$hu-ry,* 
...

NewYork sth

NBvv York Maonolia :

Ausiin 
:

Dallas )*------.-'.-*i

Houston i'l
Houslon Leighton I

2E.2:4 , -14,??g,e?e
$11699',lei

19,S30i $3,258.611: $1,304,515

* ..1-11-8Il 
--t2,!6q'27-5.: 

- . . qPB9,11-9

18,744' $2,96t,950: $1,1 53,001

-.-11',2,6l, . 
-,r1,9i9l 

i9i . - - !IJi.,z!ll
1 7.9?6i $3,022,658: $1,254,093

7;676: - $1,2S3,707: $511,684

18,094r ,. $2,s60,367: $1,201,876

28,264 $4,621,854 51,870,888

17,O7gt $2,6S9,673: $1,060,31 0
:

12,385: ' nr$1,9?0,034: $754,86?-:'
13,916i S2,303,183: 993S,226

l s,g9e_ " *$3,141,7?4 $'r,2s2,6-s0

12 Savethe document.
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Concatenating different character strings

W Introduction
The character used to link two strings together in a formula, or concatenate
data, is the plus symbol "+". The syntax is:

"St ri ng1 " + "Stri ng2"

Note: You can concatenate as many strings together as you like.

lf you want to concatenate a number or a date with a string you must first
convert the number or date to a string. To convert a date to a string you can
use the FormatDate function. The syntax for this function is:

FonmatDate ( [date] ; "str i ngfonmat" )

For example:

FormatDale( [Start Date] ; ddlmm/yyyy" )

To convert a number to a string you can use the FormatNumber function. The
syntax for the function is:

FormatNumber( [number] ; "stri ngformat" )

After completing this unit, you will be able to:

. Combine two strings in a formula using the concatenate function

W How to concatenate a string with a date

To explore concatenating different data types, consider combining a string
value with the Last Refresh Date free-standing cell formula.

The Last Refresh Date free-standing cell displays the date and time that the
document was last executed in a cell in the reoort:

116O6 4:32 PM

The syntax for the formula of the cell is:

LastExecuti onDate( )

First, you insert the Last Refresh Date free-standing cell into an existing report.
To insert a descriptive string prior to the date you concatenate the two.
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To concatenate a string with a date
1 Continue using the Doc_Marginperformance document.

2 In Edit Report view, click the Templates tab then click + to expand the
Free-Standing Cells templates folder.

3 Click + to expand the Formula and Text Cells templates folder.

Datr ; Trutates: llapr-Frucrti:.:j

: TGhd.*6 +

- ffin"o''iir"*;t. --- ,, 
'3'l Beport i

: 6 T"Ho
: t- A. i Horizontal Teble I

' , vq0cal | 4E ]
JA..-..r.ts t

F rorm

f,: lli chdts
t gd ual

, s-fti Lne
\'#Area I

. +r$piu i
: ril .: Fadd t

tr iJ Froe.Standingcells

i1 :l Forrula and Tdt Ceils

U EIENK LEN

I L: D'illFilte,.,,.:@l
. ' l:l Docum.ni name

rl ;J Paqe Numbs Cells

4 Drag the Last Refresh Date cell template and drop it in a blank area of
the report, to insert a new cell.

A new cellautomatically appears in the report, and the cell displays the
date and time that the queries in the document were last executed.

5 Click the Last Refresh Date cell in the report to highlight it.

1Sr05 4:32 PM

:Califarnia Los Angeles Princes Slreet 26,114 $1,220,92S $1,669,395

'California San Francisco Ocean Lane 1 S,830 $3,259,611 $1,304,51 5

ColDredo 9olo1ad0 Springe WailaceRoad 12,78i $2,060,275 $808,149

DC Washlnqton Tolbooth Tolbooth Street 1 8,744 $?,S61,950 $1,1 53,t01

:Florida tuliami Sundance Sundanca Place 11 ,267 $f,879,'1 58 $777,281

.lllinois Chicago 33rd 33rd Streei 1 7,S76 $3,022,65S $1,254,0S3

:Massalhusetts BoslonN#bury 
f.llor"o*ntr :,:l: ::,:::::: -::ll:::

6 Click the ShodHide Formula Toolbar button on the Report toolbar.

7 On the Formula toolbar, click the Formula Editor button.
The Formula Editor appears. Note that the formula used by Last Refresh
Date free-standing cell template appears automatically in the Formula
zone.
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9

10

8 Position your cursor just afterthe equal (=) sign in the Formula zone, and
insert the string "Last Execution Date: " + after the = symbol.

Validate the syntax of the formula.

Click OK and resize the cell as appropriate.
It should now appear like this example:

Last Erecution Date: 1l25OG

11 Save the document.
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Using date functions

ffi Introduction
The three most commonly used date functions are:

. ToDate: changes the data type of a value to date

. CurrentDate: gives the date today

. DaysBetween: calculates the number of days between two dates

In this unit, you will consider the process of converting a string to a date as
dates are often formatted as character type at either the database or universe
level.

You will use all of these date functions to create a variable named Trading
Years.

After completing this unit, you will be able to:

. Use date functions to create a variable

. Convert a character string to a date value

W Converting a string to a date value

Example
In the eFashion universe, there is no object for number of years trading. The
universe only has the Opening Date dimension object. You want to create a
variable that calculates the number of years that stores have been trading,
based on the date the stores opened.

To conaert a string to a date oalue
1 Continue using the Doc_Marginperformance document.

2 Click Edit Query in the Java Report Panel, to edit the query.

3 Add the Opening Date dimension object to the query, from the Store
class and the Store details sub-class.
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In Edit Report view, drag the Opening Date object from the Data tab and
position it to insert a new column to the rioht of the Store address
column.
The table now appears like this:

Last Execution Date: 1/25D5

:California Los Angeles Princes s:treel eQZgB 1 2:00:00 Atr4 26,244 $4.220,925: $1,

California San Franrisco Ocean Lane 3l?1/98 1 2:00:00 Ail 1 3,830 $3,258.641 51 ,

:Colorado Colorado gprings Waliace Road l1l3/84 12:0[:00AM 12:787 $2,060,275 $

DC WashangtonTolbooth TolboothStreel 12/5rs812:0000AM 18744 $2,361,950 $1,

Florida MiamiSundance SundancePlace 2/23JS4'12:00:00AH 11,267 $1.879,15S: $

lllinois Chicaqo 33rd 33rd Street 311 4/S6 1 2:00:00 AM 17 ,976 $3,0?2,658 $1 ,

'Massachusetts Boston Nembury NewburtA€nue l1121r97 12:B0r00Al ?.676 $1.283,707 $

\los/Ynrk NipilvnrkSih qthAvah.rp 6d?iF61?nnnnAM 1ffnqd S?q6n?67 $1

Note: The values returned by the Opening Date object are displayed in
the format "mm/dd/yy hh:mm:ss AM."

5 In the Edit Report view Data tab, position your cursor ne)d to the
Opening Date object.
A pop-up help box appears, providing details about the object you have
pointed to. In this case, you can see that the data type of the Opening
Date object is the character-string type.

G,-1*t! if*prP63'l L .e #"1; #ffi
:udd + irffi.:f1:ffffi:::

;;@bAbh;s.e;dr';

Before you can calculate the trading years you need to strip out the time
element of the string and then convert it to a date type.

Use the SubstrQ function to strip out the time element of the string.
However, the date element is not in a constant format (for example, some
days and months are expressed as single digits while others are two
digits).

Since the date is always followed by a space you can use the PosQ
function to define the number of characters element of the Substo
synlax.

'l 0peninq date
":l

-"1
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Create a variable called Date_Substring based on this formula.

=SubStr"([0penjng dalel ; 1 ; Pos([0pening dalei ;" ")-1)
Create another variable called Open_Date to convert the IDate_
Substringl values to date type using this formula.

=ToDate( [Date_Substr"ing] ; "nn/dd/yy" )

Note: The date must be formatted in the same way as the string that is
being converted. For instance, if the year in the string is two digits
you must express the date format as two digits.

Save the document.

W Using date calculations

Now that you have created a date type variable for the store opening date, you
can calculate the number of days to the current date in days using the
CurrentDate and DaysBetween functions. The syntax of the DaysBetween
function is:

Daysbetween(dare 1 ; date 2)

Date 1: The oldest date

Date 2: The most recent date

To create a date calculation
1 Continue using the document from the previous procedure.

2 Create a variable called Trading_Years based on this formula:

=DaysBetween([0pendateJ ; CurrentDate( ) ) /365.25

Note: To convert the days to years, you must divide by the number of
days in a year and in so doing take account of leap years. Hence,
the date calculation is divided by 365.25 days.

3 Drag the new variable Trading_Years onto the Opening date column in
the table.
The Trading_Years variable replaces the Opening Date column in the
table block.

Last Execution Date: 1i25r06

California LoE Angeles Princes Slreet

California San Franciscc ,Ocean Lane

CllEfado Colorado gpriffgs Wallace Road

DC Washinglon Tolbooth Tolboolh Slreel

FlBrida Miaml Sundanre Sundance Place

lllino e Chirag! l3rd 3Jrd Slreei

l{assachusetls EostonNewt'ury NewburyAvenue

N€wYork NewYorksth 5thAvenue

NewYork NewYorkMagnolia M?gnolia gkeet

Texag Ausili Forfee Street

siSf

801

1?]fiff,

905

tr2.t4

10 03

0.0J

?l,01

;a

!4-96

26,24 4

1 S.830

t?,78?

1 8,744

11,261

1 i,976

7.678

1 8,094

28.264

1i .07 E

$4,220,92S $1.868,3115

$3.258,641 $1,304,51 5

$2,060,275 $808 1 4S

$2,961,S50 $1 ,1 53,001

$1 ,87S,1 5g $r77,2r11

s3,022,658 51.254 093

$1 ,:83,70i $51'1 ,684

$t,960,387 $1,201 876

$4,621,851 S1,870,868

s? 69S D7-1 61 .060 3't rr

Note: The results in your table will differ from the example shown as it
displays the date of execution.

4 Change the new data column to the Number format of your choice.

5 Save the document as Doc_Marginperformance2.
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@ Practice

Activity: Character and Date String Functions

Objectives
Use the SubStrQ functions in conjunction with the Length0 function to do high-
level string formatting.

Instructions
Create a report showing the margin performance across all eFashion stores.

1 Create a report using the eFashion universe and select the following
objects:
State, Store name, Quantity Sold, Sales Revenue, Margin

2 Apply a sum to all measures.

3 There is a lot of repetition in the Store name column. Create a variable
called Store to remove the eFashion from the Store name.

4 Save the report as Act_characterdatestring.rep.
Your reoort should now look like this:

California os Angeles 2E.244 $4.22t.S2S $1 ,6F8,395

laliforn ia ian Franctsco 9,830 $3,258,641 $1 .304,515

Cslorado iolorado Springs $2,080,275 $808,1 49

lc tVashinqton Tolbooth I,744 $2,961 ,95t1 $ r ,i sl,001

=lorida rliami Sundance 1 ,267 $1,879,159 $777 ,281

llin ors :hicaqo 33rd $3,02r,658 $1 ,254,Bg3

\4assachusett s loslon Newburv $1,283,707 $511 ,EB4

!ew York Jew York 5th 18,094 $2,960,367 $1 ,2111 ,876

lew'/ork {ew York Maflnolia 28,26.1 $4,621 ,854 $1 ,87tr,868

Texa: \u5ltn ,078 $2,699,67: $1 ,080,31!

Texas la ll as $1,970,0i4 $754,862

Texas 10ustfln $2,303,18: *q?c tlF,

Texas louston Lerqhlon 8,988 $3,144,77.1 $1 ,282,880

Sum: 223,225 $36.387J0 $1{.586.940
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Lesson summary

g Review

Quiz: Character and Date String Functions
1 Name at least three character string functions used in this lesson,

2 To find the occurrence of a comma in an object's value, which function
would you use?

3 What is the syntax for the ReplaceQ function?

4 What does concatenation mean?

5 Give an example of something concatenated.

6 What happens if you put text and a date together in a variable?

7 How do you resolve this?

8 Can you do calculations on a date?
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summary

After completing this lesson, you are now able to:
. Describe the character-string functions presented in this lesson
. Use the Replace0 function to replace "Q" with the word "Quarted'
. Use the Right$ function to delete characters from a character string
. Use the SubStringO function to extract a character string from within a

string
. Use the Pos$ function to return only certain characters from the start of a

string to a specified character
. Gombine two strings in a formula using the concatenate function
. Use date functions to create a variable
. Convert a character string to a date value
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Lesson 3

Using lf Logic

This lesson shows you how to use the lfQ function formula in a variety of ways,
including how to group values in a variable, and how to modify the way
calculations behave when certain values are returned by an object.

ln this lesson you will learn about:
. Grouping data
. Using the lfO function to modify calculation behavior

Duration:1hour

Copyright @ 2006 Business Objects. All rights reserved. 3-1



W Intuoduction

o2

24.372

o3
24.95v.

ot
27.49X

o4

22.99X

Year's First
Half

52.OA',A

sl Hali | 116,:i
ar 5 SPEond Half | 107

Year's Second
fl€lf

47.94X

ln this example, the Half Year variable looks at each value for the Quarter. lf
the quarter's returned value is either Q1 or Q2 then the variable displays the
words "Year's First Half" and if the quarter's value is anything other than Q1 or
Q2 then it will display the words "Year's Second Half".

Groupi.g data

The lfQ function is a powerfultool available to Web Intelligence report
designers. Also referred to as "lf...Then...Else" logic, the lf() function is
commonly used to group values returned from the database into categories.
Using the lf$ in this manner, report designers are empowered to perform the
report equivalent of the Decode, Case, and lf functions available to universe
designers at the database level.

lfQ can be used to group some of the values returned by an object, and then
define that grouping as a new variable in the document.

After completing this unit, you will be able to:
. Group values using the lfQ function
. Define the grouping as a new variable in the document

ffi Grouping values with the If() function tow show higher levels of details

You can use the lf$ function in Web Intelligence to group values returned by
an object into categories. These categories can then be used as the basis {or
aggregating measures at higher levels of detail.

For example, the eFashion universe contains Quarter and Quantity Sold
objects, which allow you to analyze the quantity sold totals for each quarter.
However, if your reporting requirement is to display the quantity sold measure
aggregated at the half year level of detail, then the universe does not provide
the objects you need to meet this requirement.

By creating a Half Year variable based on the Quarter object, you can
aggregate quantity sold totals for each half of the year. This data can then be
presented in the same report with quantity sold totals for each quarter.

Suantitu sold

Q'.latitg sold
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The syntax used with the lfQ function is:

=1f( [object name] = "true val ue"; "va 1 ue to di spl ay i f
tnue"; "val ue to dr'spl ay j f fal se" )

Scenario
You want to show sales revenue broken down to the half-year level. Since no
object exists for half year in the eFashion universe, you will create the formula
and define it as a variable in the document.

To group values using the If) function in a formula
1 Create a new Web Intelligence document using the eFashion universe.

2 ln the Edit Query view of the Java Report Panel, drag or double-click the
Year, Quarter and Sales revenue objects to move them into the Result
Objects pane.

, 0da i Pmah*;
:: Cl eFdshior

n*nW
!-: ,g! Time perod

__: :l year

, 4 Fiscal Period

' a oudtel
:i' :t Month

1r '.1 lJeek
i -:t Holiday [y/n)
' 'if LnstYcnf

I f ThisFal
- ,t ChEimas peilod

'f HolidaY Period

i+: dl Srore

+ el orodJct

i+: t , Promotions

i: dl Measures

,- -,rE@ - :
6 At 0b@fis f :Hsmtier
F.^ - i --::*

:ilu4v l :

"1 Yea "I 0 dter J sales 'even€

: i r- :: r:" I

Click Run Query.
You will now use the values of the Quarter object to generate the needed
Half Year groups:

Quarters = Half Years

Q'l + Q2=Year's First Half

Q3 + Q4=Year's Second Half

In Edit Report view, click the Variable Editor button on the Reporting
toolbar.

In the Variable Editor dialog box, create a new variable called Half Year.

Verify that the variable is qualified as a dimension.

Build the variable's formula using this syntax:

=lf( [Quarler"] InLi st( "Q1"; "Q2" ); "Year's Fi rst Hal f";
"Year's Second Hal f" )

5

6

7

iSabs revenue 9-g revenue ol sKU sold
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8 Click the Validate button to check your syntax.
The Variable Editor appears as below:

JVacble 
Deffion *- 

-, N*, f@.-
i ougirirrt* 5 o*n.'on -
li:

Ittlobirctl ldi*l"valrc l'."vahe 2". ,--."vr&rc
n"l;apmsim-it-hm;erpcsim-if-f alsel

r& Mqe & thb functim

oK J cacer I Heb I

Click OK to create the new variable and close the Variable Editor.

The new variable appears in the Data tab in Edit Report view.

Data i rill*rdi?iiiklgEt ggl
Data +

Typg ffi

tNot

it HalfYear
':l 0udrtel

A Ye€r

t Sales revenue

10 Drag the new variable and drop it to the right of the Year column.

11 Remove the Quarter column from the table.

12 Place a break on Year.
The table appears as shown here:

Year's First Half ,!4,939,103

Yeaas gecond Halt $3,1 56,421

Yeaas First Half $6,1 66,823

Year's Second Hall $7,065,423

Year's First Half $7,749,706

Yeafs Second Half $i,309 436

i0D!

13 Save this document to your Favorites folder as Doc-lfGroup.

?003

"gl ig"9':':1"-,=Z

iAll

iAnd

i8"t*""n
iEtoct.

iEody

iEottom

I Ereak

lDistinct
iFotAll

lForEdch

lln

IncludeEmpt!

t'l

tFlalub

ill[[0uartetl Inlist["01 ";"02" ]; 'Yeais Fitst Half": 'Yeeis Second Half"l
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Grouping values with the IfO function to
show categories

Your reporting requirement is to display revenue totals in both a table and a 3D
pie chart aggregated for each of the eFashion Market Types. The three market
types are Major Market, Mid Market and Minor Market. Each state will need to
be assigned to the appropriate market type based on the following business
rutes:

Markets States

Major Market California, New York, Texas

Mid Market Colorado, DC, lllinois

MinorMarket Florida.Massachusetts

You will need to display state revenue figures including market-type subtotals
in the table and market-type revenue percentage breakdowns in the chart.

To use the If) function to show categories of ztalues

1 Create a new Web Intelligence document using the eFashion universe.

2 In Edit Query view, drag or double-click the State and Sales revenue
objects to move them to the Result Objects pane.

3 Click Run Query.
The report appears in Edit Report view.

Report Title

4 Click the Variable Editor button on the Reporting toolbar.

5 In the Variable Editor dialog box, name the new variable Market Type
and verify that the variable is qualified as a dimension.

6 Click the Functions tab and double-click the lf function to insert it in the
formula.
The lf {unction is inserted in the Formula zone, automatically preceded by
the = sign.
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7 Check that your cursor is inserted between the parentheses that follow
the lf function.

8 Click the Data tab, and double-click the State object to insert it between
the oarentheses in the formula.

9 Click the Operators tab, and then double-click the InList operator.

10 Type a single parentheses ( character.

11 Begin typing the values that will define the Major Market states.
Remember to enclose each state in double-quotes and separate the
values with a semi-colon.

12 Type ) to close the parentheses.
The formula now appears like this:

X\/
i-rrrrs*[cn;lllirliiil
il

Position your cursor to the far right of the formula. Type a semi-colon ;

and then "Major Market", followed by a semi-colon ;.

Note: Remember to include the double-quotes, and to separate all
expressions with a semi-colon.

The unfinished formula now appears like this:

13

.?dlffi -
.

I ..'

riiiii{H;iilL6ti',c;iiioinl''r;nl*viii.rr-'1",i,'i-"viio'r.,itii:6i"1 i
t' 

,

I

i

...,...''..........,..''.'''..''....''.'.'''..''..''i

Now that you have defined the three states that fall into the Major Market
category, you will define the states that fall into the Mid Market category.

14 Following the same procedure, continue defining Mid Market category,
using the following syntax:

If( [State] lnLi st( "Col orado" ; "DC'
lvlanket";

The unfinished formula now appears like this:

i Folmula:-- -

x,,,.:/
=lf[[State] lnListl"Californie";"NewYork":"Texss"];"Maior Markel"; If[[Stdte] lnList J"Coloredo";"0C" j "lllinois"]j"14id Mdr[-"t"

Now that you have defined the states that fall into the Major and Mid
Market categories, you will define the states that fall into the Minor Market
category.
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Because all remaining states fall into this third Market Type, you can
simply handle the grouping by specifying that Minor Market is the value to
assign to any state that does not fall into the first two Market Types.

15 Complete the formula using the following syntiax:

"Mi nor Ma rket " ) )

The completed formula now appears like this:

.Fry9
i:ixI .. .

'ii

16 Click the Validate button to check your syntax.

17 Click OK to create the variable and close the Variable Editor.

The new variable appears in the Data tab in Edit Report view:

To display the grouped data in the report
1 Drag the new Market Type variable from the Data tab in Edit Report view

and drop it to the left of the State column in the existing table.

2 Select the Market Type column in the table and click the InserURemove
Break button on the Reporting toolbar.

3 Select the Sales revenue column and click the lnsert Sum button on the
Reporting toolbar.
The report appears as shown here:

; Data i lrnul*.ii. i hlai,l Pmrtisi .i

1D"t"..:''''1':'''';.''''i::.;-'.ffiffi
..'!,-t-.."......,r.,.........,..........,.,,...:),:,;.:,:,;,..:t 

liiilir;ii*4riliffi*ili'i*r
:l Xy Document ij Major Market Califomia $7,479,569

:t!@[@ i r"*"orn $/,5s2,??1-, Stale I I

.l Sales revenue i: Texas $1 0,1 1 7,664

Malor Markel Sum $25.1 1S,454

Mid Market

Mid Market

Colorado

DC

lllino i s

$2,060,275

$2,S61,950

$3.022,968

$8,045,1 S3

Minor Markel

Minor Markel

Florida

Massarhusetts

Sum:

$1,87S,-t5S

$1,283,707

$3,1 6?,865

o,n5;1;Ygffi ,;|Jff,:;l$9%'
i Datd +
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To display the grouped oalues in a chart
1 In Edit Report view, click the Templates tab.

2 ln the Charts templates folder, expand the Pie folder.

3 Drag the 3D Pie Doughnut template and drop it to the right of the
existing table in the report.
The Java Report Panel switches to View Structure mode, so that you can
swap objects in the chart without actually displaying the data.

:i'

=lMarketTypel =l$tatel =lgales revenue] liii i:,r:.:" r,:r,t,

=[MarketTyFe] Surn m(lgales revenuel) i,, :" ':ta

gumr m(lsales revenue])

Click the Data tab.

Drag the Market Type variable and drop it where the chart template
displays Place dimension objects here.

Drag the Sales revenue object and drop it where the chart template
displays Place measure objects here.

Click the View Results button on the Reporting toolbar.

The pie chart appears beside the existing table. You can now edit the
chart as you choose, by displaying the revenue values as percentages or
real numbers.

4

5

Maior Market

Maior Market

Califomia

New York

$7,47S,569

$1,582,121

$1 0,1 1 7,664

$25.1 79,454 Market TyFe
I Malor Mafket
:i L{id lr'larket

E ldinor l!,lafket

Mid Market

[4id Market

Colorado

DC

lllino i9

$?,060,?75

$2,961,950

$3,022,S68

$8,045,1 S3

Minor Markel

Minor Market

Florida

hlassachusetts

Sum

$1,87S,1 5S

$1,283,707

$3,1 6?.865

Sahs rawnua
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W Practice

Activity: Grouping data

Objective
. Use the lfQ function syntax to group data values

Instructions
You want to group store managers by their degree of experience managing
their store. Then, you are going to create a report that shows the sales revenue
earned by each manager in each tenure-type category.

It is necessary to create a variable to group the managers into categories,
because experience, or tenure type, is not an object that is available in the
eFashion universe.

1 Create a new Web Intelligence document using the eFashion universe.

2 Include the Name of manager, State, and Sales revenue objects in the
query.

3 Create a variable called Tenure type.

4 Qualify the variable as a dimension.
5 Define the formula to group each store manager into a category, based

on the following tenure-type categories:

Tenure type Name of manager

Rookies Bennett

Leonard

Tuttle

Subs Queen

Veterans Anderson

Barrett

Larry

Mark

Michelle

Quinn

Richards

Steve

6 Insert the Tenure type variable into the table so that its values are
projected in the first column in the table.
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Format the report so that it is organized in blocks that show the sales

revenue earned by the managers in each tenure-type category'

Your report should look like this example:

ilewYork

DC

T€xas

Massachusetts

lllinois

+,lBwYgrk.

califorflia

$2,303,1 B3

$+,s{!,asl

$2,S61,950

$2,ECS,673

$1,283,707

$.3 1 411174

$3,02?,658

$1,s601367

$7,47S,569

Aridlil!l
Baretl

:fary .

Mark

MithElls,

,Guinn

ilichflds
Steve

:Velefans : ,

SsavethedocumentinyourFavoritesfolderasAct-Groupdata.
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Using the IfO function to modify calculation

The lfQ function is useful for extending the functionality and flexibility of
calculations in reports. More specifically, by using the lf$ function, report
designers can change how a measure behaves based on each value returned
for an object.

After completing this unit, you will be able to:

. Use the lf() function to modify how data is calculated depending on the
values returned by an object used in the report

behavior

'@ Introduction

&q# Modifying the way calculations behave

You can also use the lf() function to extend the functionality of calculations so
that they behave more dynamically.

The syntax for using the lf() function to modify the behavior of calculations is:

=If([object name]= "true va1ue"; Imeasurel behavior A;
Imeasure] behavjor B)

In other words: if the value returned by an object is equal to what is specified
in quotes, then the calculation should behave in a certain manner; otherwise,
the value should be calculated in a different manner.

Scenario
You want to build a report that calculates the target revenue for each Store
Name. Each store has a different percentage of growth it is supposed to
achieve based on the state in which it is located. Therefore, a single calculation
will not work.

The stores in the following states are to grow their revenue based on these
percenrages:

State % Growth Required

California 5%

Colorado 10%

DC 15%

Florida 15%

lllinois 15o/o

Massachusetts 18%
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State % Growth Required

New York 15%

Texas 15"/"

1

2

+Fashion Los Angeles

e-Fashion San Francisc0

e-FashiDn Colorado gprings

e-Fashion Washinglon Tolhooth

+Fashion Miami Sundance

e-Fashion Chicago 33rd

e-Fashion Eoslon Newbury

e'Fashion New York 5th

FFashion New York Magnolia

e-Fashion Austin

e-Fashion Dallas

e-Fashion Houston

eFashion Houston Leiqhton

s4,220,929

$3,258,641

$:,060,275

$?,961,950

$'t ,s7s,1 59

$3,02?,659

$1,283,707

$1,960,367

$4,621,S54

$2,69S,673

$1,970,034

$?,303,1 83

st.1 44,774

6

7

To create a aariable that calculates grozath in reoenue
Create a new Web Intelligence document using the eFashion universe.

In the Java Report Panel, drag or double-click the State, Store name and
Sales revenue objects to move them to the Result Objects pane.

Click Run Query.
The report appears as shown here:

California

California

Colorado

DC

Florida

llli nois

Massachusetts

New York

New York

Texas

Texas

Texas

Texas

Now you are going to calculate each state's target revenue, based on
their expected growth.

In Edit Report view, click the Variable Editor button on the Reporting
toolbar.

Create a new variable called Target Revenue Based on Required %
Growth.

Check that the variable is qualified as a measure.

Use the lfQ function to define the syntax of the variable as follows:

=1f( [State]="Cal i forni a " ; ISal es nevenue]*1.05 i
If([State]="Colonado" ; ISales nevenue]*1.1 ;

if( [State] InLi st ( "DC" ; "Fl orida" ; " Il I inoi s" ; "New
York";"Texas ") ; ISales revenue]*1.15 i

I f ( [ S t a t e ] = " l"l a s s a c h u s e t t s " ; I S a I e s r e v e n u e ] * 1 . I B ) ) ) )

Note: When you insert this formula, be sure to include a blank space
after Texas and before the closing quote. Texas is entered in the
database with a space at the end. Otherwise, the value for Texas
will not be calculated in your report.
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8

I
Click the Validate button to check your syntax.

Click OK to close the Variable Editor.
The new variable appears in the Data tab, in Edit Report view.

To calculate the data anil project it in the table
1 Drag the new variable and drop it to the right of the Sales revenue

column, to insert the calculated target revenue data in a new column in
the table.

2 Format the new column header cell so that the variable name text is
displayed fully in the cell.
To do this:

I Click the new column header cell to highlight it.

2 Click the Properties tab.

3 Expand the Text Format section in the Properties tab.
The options available for formatting the text in the selected cell
appear.

i- d Stoenm
i a s"lor"u"*
i 4 TdgetRwercBasedmFeqdedErmth
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4

5

ln the Wrap text option, select Yes.

Expand the Display section in the Properties tab.

The options available for formatting the display of the selected cell

appear.

!1. t-kyl"I:*tg- ProPertres l

Properties 4

i' Texl =NemeOffi...,
,-l Oi"phf, t,

Autoht wtdth l- Yer

u/idth 108 Fx

:.: Autolit hei-qht [* Yes

:::: Heiqhl 24 px 
.

; Feddcellcontent.. Texl :

Showwhenemptv F Yes
'ili Horizontalpadding 2px
::ii Ve*ical paddinq 2 Fr

t=.AF rir=';.:i:;
::.J Tert Fornnt [Arial.9.Bold]

FDnl name Aial
Size

5r9re

undeilrne I re:
Strjkelhrough l- Yes

Tertcolor l,-,255.2a
Wrap tert F 'les :J:::a:::::::::::*:::;

lcrt 4ig!ttr€!!!
the verticnl tqt aligliffint.

6 Select the Autofit height option to enlarge the cell so that the full

variable name can be seen.

7 Highlight all the column headers in the table by holding down the ctrl
key and clicking each cell to select them all.

I In the Text Format section of the Properties tab, set the Vertical
Text Alignment setting to Center.

Change the formatting of the Target Revenue values so that they use

the same formatting as the values in the Sales revenue column.

To do this:

1 Right-click the new column and select the Format Number option

from the drop-down menu.

2 ln the Number Format dialog box, click the Currency option'

3 Select the appropriate currency display from the Properties list box

and click OK.

'..=,,;':;zzuB;
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The completed report should look like this example:

California e-Fashion Los Angeles

California e-Fashion San Francisc0

Colorado e-Fashion Colorado Spnnqs

DC e-Fashion Washinqton Tolbooth

Florida e-Fashion Miami Sundance

lllinois e-Fashion Chicago 33rd

Massarhusetts €-FashionB0stonNewbury

NBw York e-FashiDn New YBrk 5lh

NewYork e-FashionNewYorkMagnolla

Texas e-Fashion Austrn

Telas e-Fashion Dallas

Texas e-Fashion Houston

Texas eFashion Houston Leighlon

s4,220,929 $4,431.975.24

$3,25e,641 $3,421,572.53

$2,880,275 $2,266.302.72

$?,961,S50 $3,406,242.39

$1,879,1 5S $2,1 61,032.2S

$3,022,658 $3,476,057.16

$1,?83,707 $1,514,773.79

$2,S60,367 $3,404,42'1.47

$4.6?1,854 $5,31 5,1 32.21

$2,6S9,673 $3,1 04,624.1 I
$1,S70,034 $2,265,539.33

$2,303.183 $2,648,660.22

s3,1 44.774 $3.61 6.4S0.2?

Note: Even though the Target Revenue Based on Required % Growth
variable was calculated using the State object, Web Intelligence is
able to display the values at the Store name level, due to the
default calculation context of all variables.

4 Save this document in your Favorites folder as
Doc_Modifycalculations.

Syntax of the IfO function
This syntax is based on the lf ...Then... Else logic and the percentage rates that
each state is supposed to grow by.

Some considerations regarding this syntax are:
. When you list a single state, you place the "=" sign before the State value,

but when two (or more) states are listed, you use the "lnList" operator.
. The syntax requires that when multiple values (States) are listed, all the

values must appear in parentheses and each individual value must be in
quotes as well as separated from the other values by a semi-colon.
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'W Practice

Activity: Modifying the calculation behavior

Objective
. Use the lfO function to create a variable that calculates the sales tax paid

by each store, per quarter

Instructions
Using the eFashion universe, you want to display the sales tax paid by each

store, and per quarter. You need to create a Sales Tax Paid variable that uses

each store's revenue total to calculate sales tax based on the unique tax rate

of the state where each store is located.

It is necessary to create a variable to calculate this data, because neither sales

tax paid nor each state's tax rate is available as an object in the universe.

1 Create a new Web Intelligence document using the eFashion universe.

2 Include the Quarter, State, Store name and Sales revenue objects in
the query.

3 Create a variable called Sales Tax Paid.

4 Qualify the variable as a measure.

5 Define the formula to calculate each store's sales tax based on the state

where the store is located. Use the table below to specify the tax rate:

State Tax rate

California 8.5%

Colorado O,C-lo

nn 8.5Y"

Florida 7.5%

lllinois 7.5"k

Massachusetts 8.5%

New York 8.57"

Texas 6.5%

6 Format the report so that each block in the report shows the sales
revenue and sales tax paid by each store, per quarter.
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Your report should look like this example:

e-FashionAuslin ...:
e'Fashion Bost8n Newhury

e-Fashion Chicaso 33rd .. I

e-Fashisn Colorado Springs :

sFashion Datlas

e-Fashi8n Hsuston I

e-Fa,shion H.ouston, Lelgf$n!- 
:

e-Fashion Los Angeles

€-Fashign Miami sundan!9 :

e-Fashion NewYork 5th :

* F gs. !js-l' N.ew Yod( 
F 

a.Srlglig

e-Fashion San Francisto]:
i e-Faehion'Washirr$lon TBlboD

e'Fashion Austin

€-Fashion Boston f'lewbury

e-Fashion Chicags 33rd

$175,483: . $5q,406 ls

$tt z,ese: $20,338.27

seoo,+or, . 1ea,iso o:

$525,68? $34,1 69.34

*uuu,1un, - +1ul of tt
$61 4,285 i $39,S28.50

is:o,j1a. : - t9,0,0i7,.,

$t,t:g,t rg, $95,988.1 0

osrsoas , f *,uiu,u*

$604,084, $6S,347.1 ?

iirut,oio, ilootuui.ug

$7i0,503 $65,492.73

rtsu.*ii . tus,,in.*

$667,850: $43,410.?7
:

$?91 1431: - $1 S,S43 n?

$8511,595, $63,794.63
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Lesson summary

AW Review

Quiz: Using If Logic
1 What is another term for the logic used by the lffl function?

2 Which of the following are examples of why you might use the lf$
function to group values in a variable:

1 To display categories of values

2 To combine values from two different objects of the same type

3 To show values aggregated at higher levels of detail

3 True/False. You can use the lf() function to define a variable so that a
different calculation is used depending on the value retrieved by the
object specified in the variable's formula.

ffi summary
After completing this lesson, you are now able to:
. Group values using the lfQ function
. Define the grouping as a new variable in the document
. Use the lfO function to modify how data is calculated depending on the

values returned by an object used in the report
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Lesson 4

Advanced Reporting Techniques

In this lesson you will explore several reporting techniques, including formatting
multiple breaks in tables and crosstabs, building a formula to change numeric
display of months to text display, creating a custom sort, and displaying the
user's response to prompts in free-standing cells.

In this lesson, you will learn about:
. Formatting breaks
. Creating custom softs
. Displaying document data in free-standing cells
. Displaying data restricted by a filter or ranking

Duration: t hour

Copyright O 2006 Business Objects. All rights reserved. 4-1



Formatting breaks

ffi,W lntroduction
Although Web Intelligence allows you to produce reports in several different
table formats (vertical, horizontal, crosstab and form), these basic formats do

not always fulfill all the requirements that you require in your working
environment.

This unit explains several different formatting techniques, using breaks, to
display the results of queries in table formats slightly different lrom the defaults

After completing this unit, you will be able to:

. Manipulate break headers and footers to change the display of the data

. Prioritize multiple breaks in a table

. Use breaks to format crosstabs

Because breaks are often used as a method of breaking apart table data in
order to create sub-totals, one of the most important features of a break is the
break footer into which the subtotal calculation is placed. Each time you place
a break on a table, you also create a header. Since both the header and footer
are created automatically when the break function is utilized, it is important to
understand how they operate and how they can be manipulated.

To aiew default break settings
1 Create a new Web lntelligence document using the eFashion universe.

2 Build a query using the Year, Quarter, Month Name and Sales revenue
objects.

Tip: Click + next to the Month object to expand the folder and view the
Month Name detail obiect in the Data tab.

D du= :.-ll:.?.::i:-:.,....--. * - . ...::,,...

;!&";;;;G,
:l ';Ail Time percd

il I rea'

T Euetter

::r -l Month

'' 0 llonth Nanre

it: ". \t'eeh

a HolidaY [u/nJ

f Laslj,'ear
f Thi. "Fr,

Because you selected the Month Name detail object, the object that it is
associated with, Month, is automatically added to the query as well.

In the eFashion database, the values in the month table are numbers
from one to twelve, instead of the full month names. You will see that the
Month Name detail object displays the values with their full names.Click
Run Query.

Remove the Month column from the table.

W Controlling break headers and footers
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Using the Insert Break button on the Reporting toolbar, apply a break
on both the Year and Quarter columns in the table.

The table appears like this:

Fehruary

January

March

$630,073

$1,003,541

$1,027.085

rpfil

June

May

$89!r268

$51 7181S

$865,61 5

August

JUry

9eptember

$1 73,756

$525r904

$668,1 8 1

Dec ember

November

October

$64S,350

$484,0?4

$655,206

In viewing the table, you can see:
. Break header: There is a break on both Year and Quarter, but there

are only table headers for each new quarter.

. Break footer: There is a new footer for each new year, as well as
each new quarter. lf you place a sum on the Sales revenue column,
the revenue figures are calculated on both the quarterly and yearly
levels and then placed into the appropriate folder.

. The data in the table is currently sorted in the default sort order, that
is, in ascending order based on values returned by the measure
object included in the query. This means that the months with the
lowest revenue appear first, for each quarter.
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5 Click the Sales revenue column and click the Insert Sum button on the

Reporting toolbar.

The table appears like this:

De rembel

Novemb E r

Ortober

; $B3f].8r3

$1,003,5'lt

g{,c:r,gai

$:,660,r0[

s8s5,26S

tii.,*:tn
$865;615

$2,:78,693

srr3.?56:

$??8.s04

$66e,tti1

$1,36/,841

$64s.s50

- t***,*ti
$655,288

Sum $1,788,580

gum: $8,095,814

6 Save the document in your Favorites folder as Doc-Formatbreaks'
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Formatting multiple break headers and footers
There are several ways to modify multiple breaks in tables.

In the table shown below, the values for both Year and Quarter appear only
once and have been centered over the break. This was achieved using the
Center Value Across Break formatting option.

January

February

March

April

May

June

JUly

August

Septembef

Octoher

Novemher

December

$'1,003,541

$630,073

$1,027,085

$89S,260

$e65,61 5

$51 7,81 I
$5?5,904

$1 73,756

$688,1 81

$655,206

$484,0?4

$649,350

$8,095,81 4

January

01 Fehruary

'Manh

April

02 May

.llrnF

$1,335,402

$609,01 3

$1 ,381,758

$1,068,309

$1,081,885

[6qn d57

The table header in this table only appears for each Year, not for each Quarter.
This was achieved by turning off the break header for Quarter and turning on
the break header for Year.

The sum on Sales Revenue displays only the yearly revenue totals, not the
quarterly totals. This was achieved by turning off the break footer for Quarter
while retaining the break footer for Year.

In the following procedures, you will format the breaks in your table so that it
appears like the table above.
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w

To center the aalue across the break
1 Continue working with the same document.

2 Select the Year column in the table.

3 Click the Properties tab.

The Properties tab appears in the left pane.

r,rirJt:lLj:fi,,s,a.y.,*:1*;i,trPl$,}:
i Propetties

i:l$i E1 ,u; ;; .

:i 
f:d*.t'-- 

""' 
=r;

r Backqound colol

:: Background image

:::: Borders

::, tleteg.Qe!!1
,' Number format

i* *l6hks
1r $olta

lArial.9.Fegulrrl

l,loi tppficeble

Default

The Properties tab allows you to format a number of elements related to

the part o{ the document that is selected. In this case, because you have

selected a data column, you can format the size of the column, the text
displayed in the column, the background of the column, and other
standard lormatting elements.

You can also format the way any breaks and sorts applied to the column

are displayed.

Click + next to the Breaks section to expand the folder and view the
options available to you for formatting the break applied to the Year

column.
The Breaks folder expands in the Properties tab.

l:i: Show break header l* Yes

L !t o* brear iooter 17 '/es

I Femove duphcate value; l? /er
i Crnt"' values actoss bteek l* \ es

I Apply rmplicit sorl ts values |? Ye:

i r. Page layout

t tt' So,t"
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5 Select the Yes check box next to the Center values across break
option.

6 Click the Quarter column in the table.

7 ln the Properties tab, select the Center values across break option
again.

The table now appears like this (truncated in this image):

't::

o1

Februery

Ja nua ry

March

$630,073

$1,003,541

$'1,027,085

$2.660,700

April

June

May

$e95,280

$5 1 7,81 9

$865,61 5

$2,278.6S3

To remooe break headers and footers
1 Select the Year column in the table.

2 Check that both the Yes check boxes next to the Show break header
and the Show break footer options are selected.

3 Select the Quarter column.

4 Clear both of the Yes check boxes (so that the options are nof selected)
next to the Show break header and Show break footer options for the
Quarter column so that neither the header or footer rows are displaved
for the Quarter break.

5 Click anywhere outside of the table.
The table now appears like this:

WWWffiffi
February

January

Merch

April

June

May

August

A3 Juty

SeFtetrber

Derember

November

OctohEr

$630,073

$1,003,541

$1,027,085

$8S5,?60

$51 7,81 S

$1 7?,156

$525 904

$668,1 e1

$649 350

$484,024

$655,208

lrE,0s5,B14

Fsbruary

January

March

April

.llInF

$60s,0 1 3

$1,335,40:

$1,381 ,758

$1,06e,30tr

$fiqn 4f7
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As we saw previously, the Month Name column currently is sorted in the
default sort order, that is, in ascending order based on values returned by

the measure object included in the query. In this example, the values in
the Sales revenue have been sorted accordingly, with months earning the

lowest revenue appearing first in the table, per quarter'

lf you tried to change the sort order by applying a standard sort on the

Month Name column, you could only switch from ascending order to
descending order: the rows would be sorted to display the highest

earning month in the quarter first, instead of the lowest.

To change the order of the rows so that the months are deposed not

based on revenue earned but based on their order during the year, you

need to create a custom sort. You will learn to create a custom sort later
in this lesson.

6 Save the document,

About formatting breaks

Some important things to remember when using breaks are:

. Place all needed breaks onto the table before placing any calculations. lf
you place the calculations first and apply a break on an object, the
calculation context does not recognize that it should re-calculate to the
new break level (that is, create sub-totals). Place the breaks first to
ensure that the new calculation context is in place before the calculation
takes place.

. lf you place an automatic calculation, for example a Sum or a Count, on a
table after you format the breaks, you lose all formatting done on the
break footers. The default action for these calculations is to calculate on
all break levels present, regardless of how they have been formatted.
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RrEr&l

W Prioriti zingmultiPle breaks

EackOloul! colol 
...

Eackgtound maqe

Borders

teiaer iitts
eody citti
Footer cells
Allrnite Foo/c
f:a,q.qlt!F.i. :.i

When you have multiple breaks in a document, you can change the default

order so that one break is displayed as a higher priority than the other.

To set the priority of multiplebreaks in a table

1 Continue working with the same document'

2 Position your cursor over the table until a blue border appears around the

table.

3 Right-click the blue border and select the Edit Format option from the

droo-down menu.

The Properties tab appears in the left panel'

4 Click + next to the Breaks folder to see the options available at the table

level for formatting breaks.

The Breaks folder expands.

P*";.;i:**t r'rar' P;;;i;: j

;-r91ilfi rf 4
,=i 's;o-a . -,, ,

r;,; Name

:r; DitSay
;=i AppeeranCa

l:' .rr'iii:,'
: 41:
Itr
-l

)##'.'..tj!"

"'-;#i:: 'r.'P*lrlii::#J',,
You can see that currently, the breaks priority is Year followed by Quarter.

fuv"u1 0u,,, ;

rk paitriJ .,.:
lh6 h€ik.tftorrty o$s f oi tln r

click the ... (three dots) button to the right of the Breaks priority option.

The Breaks dialog box appears.

r@
':i:,* 

' *" -'il

:.r:ouarter i
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6

7

Use the arrow buttons to set Quarter at a higher priority than Year.

Click OK.
The table now appears like this:

2001

February

Jan u aly

March

FBhruary

January

Narch

February

J a nuary

March

$830,0r3

$ 1 ,003,541

$'1,0?7,085

$2,680,700

$609,01 3

$1,335,402

$'t,381,758

$3,3?6,1 7?

s8E3,452

$ 1 ,501 ,367

$1 ,3?8,1 70

s3,74?,SES

?003

2n03

Apfil $8S5,280

2001 rune $$1 7,81 I
^1 Mev $nfifi fi1 i

The data is presented with all first quarters during the three year period at

the top of the table, followed by all Q2 values. The sum is calculated at

the quarter level, and a total of all first quarter revenue is displayed as

well.

Return the breaks priority to the original order and save the document.
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W Using breaks to format crosstabs

$1,704,?1 1 S774,893 $?,78:,680

$448,307 $203,701 $768,390

$6S3,?1 1 $31 0,356 $1 ,21 5,1 58

$405,985 $1 !2,47S $661,250

$737,S1 4 $348,750 $1,1 50,659

$238,81 S $1 1 1 ,453 $1 57,71 I
$ 1 ,667,696 $773,301 $2,763,503

$3,1 99,677 $1 ,0'1 1,038 S3.732,8e9

Since crosstabs contain two levels of dimension objects (object values are
located both in the columns and in the rows of the block), several unique
formatting issues may occur. The proper use of breaks on the rows and
columns of the crosstab allows you to resolve these issues.

When two or more measure objects are used in a crosstab, an additional
header is needed to display the object names.

To use breaks zpith additional header roTDs

1 Create a new Web Intelligence document using the eFashion universe.

2 Build a query using the State, Year, Sales revenue and Margin objects

3 Click Run Query.

4 Position your cursor on the table border until a blue border appears
around the table.

5 Right-click the blue border and select the Turn To option that appears
on the droo-down menu.

6 In the Tables tab in the Turn To dialog box, select the Crosstab table
format.

7 Check that the values returned by Year object are positioned as column
headers in the crosstab, and the values returned by the State object are
oositioned as row headers.
lf this is not the case, swap the headers using the drag-and-drop
technioue.

The crosstab now appears like this:

$1 ,076,5?8 $?,3S2,673 S1 ,'t 2 t ,48S

$?94,483 $843,594 $309,966

s45r,231 $1,053,591 $385,41 5

$268,870 $81 1,9?{ $11 S,1 32

$465,478 $1 ,r 34,085 $439,865

$83,65r $8S7,1 ES $336,574

$1,1 04,278 $3,1 51 ,02r $1,1 84,1 66

$1,459,562 S4,1E5,0gE $1,580,478

Since no secondary header was added to indicate the column names for
the measure objects in the body of the crosstab (only the Year header is
present), you must add one, so that you can distinguish between the
Sales revenue values and the Margin values.

8 Right-click any Year column-header cell.

Or, click the drop-down arrow next to the Insert Row Above button on
the Reporting toolbar.

9 Select the Insert row below option from the drop-down menu.

10 Click any cell in the first data column (notthe column header).
Notice that all three of the columns are highlighted.
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-{h} p

11

13

14

Click the Properties tab and verify in the General, Text zone which
measure object is projecting data in this column.
In this case, it should display =[Sales revenue], which indicates the
values in these columns is sales revenue data.

Click the new second column header of one of the columns you

highlighted.

In the General, Text zone of the Properties tab, type the header label:

Sales Revenue.

Note: Remember to press the Return key when you have typed the text.

Click the second column header for the other columns and type the
header label: Margin.

Note: Another way to edit the header text is to click the row/column
header, display the Formula toolbar and type the text in the
Formula bar.

The crosstab now appears like this:

Notice that the values for the Year object are not centered over the new column
headers for Sales revenue and Margin. This is a problem inherent in crosstab
formatting. You can place a formatted break on the Year object to work around

this oroblem.

To apply abreak on a column header in a crosstab
1 Click in the Year row to highlight it.

2 Click lnserURemove Break on the Reporting toolbar.

The crosstab now appears like this:

?0rl?

ffiffiwtrWW
ffiffiW

$1,704,?1 1 $774,893

$448,302 $?03,701

$683,21 I $31 0,356

$405,S85 fi192,479

$737,S1 4 $348,750

$?38,81 9: $t 1 1 ,45i

$1,667,6S6 $71S,301

$2,1 9S,677 $1,01 1 ,038

$1 ,714,:1 1 $774,893

$448,30? $203,701

$693,211 $110356

$405,S85 $1 92,47S

$737,E1 4 $348,750

$2t8,81S $111 453

$t,667,6S6 $77S,301

$?,1 5S,677 $1 01 1,038

2001

$?,782,6e0 $1,0?6,5?E

$768,390: $2S4,483

$1,215,158 $457,?31

$661,250 $?66,670

$1 ,1 50,65S $465,478

$1 57,71 S $63,657

$2,763,503 $1,1 04,27€

$3,732,889 $ 1 ,45S,582

$?,992,678 $1 ,1 21,18S

$843,584' $30S,366

$1 ,053,581: $3S5,41 5

$81 1 ,S?4 $31 8,1 3?

$1,1 34,085 $43S,865

$887,1 69 $338,574

$3,1 51.022 $1,1 89,1 66

$4,1 85,098 $1 ,566,4I8

$?,782,680 $1,076,538

$768,38t $lgl,dB3

$1,215,1 58 $457,331

$661,250 $266,670

sl ,1 50,65S $465,418

$1 57,11 S $63,657

$2,763,s03 $1 ,1 04,??8

$?,i32,88S $1,459 562
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3

4

In the Properties tab, expand the Breaks folder.

Select the Yes check box next to the Center values across break
option.
Now that the values for Year are centered over the Sales revenue and
margin columns, the multiple crosstabs created by the Break can be

reformatted to look like a single crosstab.

Note: Creating a break and centering the value across the break is only
necessary because Year is the main object across the row of the

crosstab. lf the two cells were normal cells, you could use the
Merge Cells option (Properties tab, Text format folder) and center
the value across the selected cells.

To remove both the extra column and the extra white spaces in between
each crosstab (these were created when the break was placed on Year),

clear the Yes check box next to the Show Break Footer option (not

selected).
The crosstab now appears like this:

re

$1,704,?t 1 $774,593

$448.302 $203,701

$633,21 1 $31 0,358

$405,985 $1 92,47S

$737,S1 4 $348,750

$238,819 $111,453

$1.667,896 $779,301

$2.199.677 $1,011,038

$2,78:,680 S1,076.52S

$768,390 $254,481

$1,?1 5,1 58 $457,231

$661,250 $?66,670

$1,1 50,65S $165,478

$1 57 71 I $63,657

$2,r63,563 $'1,104,278

$3,732,88A $1,45S,581

$2,99?,87S $1,1 21 ,489

$043,584 $103,966

61 ,053,581 $385,41 5

$81 1 ,S?4 $31 8,1 32

$1,1 34,085 $433,865

$fi97,1 63: $336,514:

s3,1 51 ,0?? $1 ,1 89,1 6B

$4,1 85,098 $1 ,568,4i8

Breakscrosstabs.6 Save the document in vour Favorites folder as Doc
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DaY w"ar

Ouierwear
Hats,gloves,scatres

Night wBaI

r.Bl9lgl '
thetland Jackel

$.'12Sr4B

$1 6S.70

t91:e5

$21 9.73

F.lorl/llel:$tem Patternqd silk 5!9rf

Twill Dressing-qown

Drywear

Oderco€ts

Wet wear

Fake F,urOveLc-oal

velour oYercoat

High Collar Engineers Raincoat

Stretch Cotton Raincoat

Trenchcoal

Sum:

[! e8,60

fi283.47

:$?30r91

$211.91

$209 ss

$1,656.04

Average:

$58,948

$1 48,825

$1 1370

$21,431

$5e"37?

$31,0?1

save the document to your Favorites folder as Act_Formatbreaks.

ffi Practice

Activity: Formatting breaks

Objective
. Format a table using breaks.

Instructions
1 Use the eFashion universe to create the report shown below:

$'l 1l "s*7
$1 ,664

$4?1929

$41 ,71 6
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Creating custom sorts

.4&W Introduction
You can apply sorts to the results displayed in:

. Section cells - to organize the order in which sections are displayed in a
reDon

. Tables - to organize the order in which results are displayed in a column
or row

Sorting sections enables you to organize the section headers logically in a
report. For example, if you have created sections on a report for each year, you
can apply a descending sort so that the sections are organized with the most
recent year as the first section and the earliest year at the end of the report.

You apply sorts to any dimensions, measures, or details displayed on a table.
Sorting dimensions and details helps you organize results chronologically,
while sorting measures helps you see highest or lowest results at a glance.

This unit describes how to create a custom sort. Custom sorts allow you to
define your own order for the data displayed in a report, other than the default
orders that are available with standard sorts.

After completing this unit, you will be able to:

. Exolain the default sort orders available in Web Intellioence

. Create a custom sort

. Apply a custom sort to a column of data

. Delete a custom sort

X4

W About sorts in Web Intelligence
Sorts in Web Intelligence allow you to use lhe following orders:

Sort order Description

Defaull This is sometimes referred to as the "natural" order.
Depending on the type of data in the column or row, the
results are sorted as follows:
. ascending numeric order for numeric data
. ascending chronological order for date
. alphabetical order for alphanumeric data

Ascending When selected, results are arranged in ascending order:
The smallest value at the top of the column moving to the
highest value at the bottom. For example: 100, 200,300 or
California. Colorado. Florida.
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Sort order Description

Descending When selected, results are arranged in descending order:
The highest value at the top of the column moving to the
smallest value at the bottom.
For example: 300, 200, 100 or Florida, Colorado,
California.

Custom You define your own sort order.

W How is data sorted when you apply a break?

When you insert a break on a dimension, the values for the dimension are
automatically sorted in ascending order. lf the values are numeric, the lowest
value appears in the first row of the table, the highest in the last row. lf the
values are alphabetical characters, then the values are sorted in alphabetical
order from top to bottom. You can change this sort order at any time.

.e. I
:;:- |

H

.ffiW Creating a custom sort
To create a custom sort
1 Open the Doc_Formatbreaks document that you saved to your

Favorites folder earlier in this lesson.

2 Right-click the Month Name column and select Sort from the drop-down
menu.
Or, click the drop-down arrow next to the Apply/Remove Sort button on
the Reporting toolbar.

3 Select Custom sort... from the drop-down menu that appears.
The Custom Sort dialog box appears.

f,rs{i! s c6tm ssl tq "'l M#ih |1@
f ie w ryOe * +ipo udffi $k o6*ecl 

^ 
used;arepqt

;Iffi,,:iLir,i;;,rii
:: !,:j.t::,::r ;.ril:,r iY,iii :

i" 1""+" "n* {,'* O*;
sea& 4pea n*Edocrrrm,
l,Pe+r$tr,f,, rl#r*e.E

Auou5t
i"i ,0r""rb",

. reEluerJr

,+ | ;J"nuarv

1:l :l"tt
'' I ,June

l'.lotch

Mal

Novembet

.-o* I ,3* | H"b 
I
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Use the Up and Down arrow buttons to order the months in the standard
order so that the Custom Sort dialog box appears like this:

OgaF i qlEqr sl ls -l ldcsdhffi
Tle m odg vd.rysa,*r**t'* *pu ir d r; t**t

d
:l::I,.1'

$ 1.!03,541

s630,073

$1.027,0€5

$895,2611

$865,61 5

$51 1,81 S

$5?5,904

$1 73.756

$668,1 € 1

$184,0?4

$649,350

$8,0s5,81 4

W
:Januar/

G1 February

Deleting a custom sort

To delete a custom sort, select the Delete Custom Sort option in the Custom
Sort dialoq box.

Tryoa;rld*e

To irdd€'a vEil#'ihddo?e d
ru ;Fq9aii*red*"!a!t, i

q*ir?b*4d*sdda$trF i

Mach
iApnl

ili l't"Y::Jure

I,t uty

-llAusmt
:il5epiember
::l0ctober

{ l rq,.4 1 }r€b I' @

Click OK to create the custom sort and close the dialog box.

The table now appears with the data sorted in the order of months in the
year:

Janu?ry

F e hru ary'

March

Apnr

May

June

JUry

AUgUSI

September

Ottober

November

Decembel

2001

$11335,40?

$60!,0 1 3

Marrh $113€11758

April $1,068.30S

02 lvlay $1 ,881,685

.lilnF S6qrr 14?

::1i".:":l

a.4.:"tr.:..t
:: :t:t-.:,,,i
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Displaying document data in free-standing cells

@ Introduction
This unit describes how you can display certain data available in the document
as a free-standing cell in the document reports.

After completing this unit, you will be able to:
. Display the user's response to a prompt in a title cell
. Display the date that the document was last refreshed

@ Displaying the user's response to a prompt
You want to capture the user's response to a prompt and display the updated
value in the title every time the document is opened or refreshed.

To create the document utith a prompted query filter
1 Create a new Web lntelligence document using the eFashion universe.

2 Build a query using the Year, Quarter and Margin objects.

3 Create a prompted query filter that requires the user to select a state
every time the report is opened or refreshed.

4 Click Run Query.

5 When you are prompted, select lllinois.
5 Apply a break on the Year column.

7 Apply a sum on the Sales revenue column.
The report appears like this:

Report Title

AJ

o2

o3

Q4

$1 1 5,S82

$1 1 4,847

$48,5?0

$6S,50'1

$348,750

a1

a2

G3

Q4

$1 28,e78

$1 00,760

$sl,7S4

$1 44,n46

$465,478
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You are going to create a formula to capture your response to the prompt. To

create the formula, you will use the UserResponse$ function, but you will also
need to use the DataProviderQ function and any of the objects used in the
query.

To show prompt input with the UserResponse0 function
1 Click the Report Title cell to highlight it.

2 Click the ShodHide Formula Toolbar button on the Reporting toolbar.
The Formula toolbar appears and displays the text that appears in the
title cell currently: Report Title.

3 Click the Formula Editor button on the Formula toolbar.
The Formula Editor appears.

4 Type or use the Data, Functions and Operators tab to help you enter
the following formula:

="Quanterly Revenues fot "

+ U s e r R e s p o n s e ( D a t a P r o v i d e r ( [ Q u a r t e n ] ) ; " t n t e n S t a t e " )

5 Click the Validate button to check your syntax.

6 Click OK to close the Formula Editor.

The title cell has been updated with the text you entered in the formula,
plus the state that you selected when you last ran the report, lllinois.

Quarterly Revenues for lllinois

01

ol
trl
Q4

$1 1 4,847

$48,520

$6S,501

$348,750

o1

a2

a3

o4

s1:8,978

$1 00.760

$s1,794

$1 44,040

$,165,47e

-?nn3 rX1 $93 1 nq

7 Click Refresh Data.

8 When you are prompted, select New York.
The table is updated to show data concerning New York and the title cell
is updated as well.

9 Save the document to your Favorites folder as Doc_Displayprompt.
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W Displaying the last refresh date

You want to display the date and time the document was last refreshed in a
free-standing cell so that the data will be updated every time the document is
refreshed.

To display the last refresh date in a cell
Continue working with the Doc_Displayprompt document.

Click the Templates tab in the left panel.

Click + next to the Free-Standing Cells folder to expand the folder.

Click + next to the Formula and Text Cells folder to expand it.

Drag the Last Refresh Date template from the Templates tab to the
blank space to the right of the existing table.

Right-click the cell and select Format Number from the drop-down menu
to change the format of the date and time.

Expand the cell or reduce the font size as necessary to view all the text.

Insert a free-standing cell and type text to identify the Last Refresh Date
information.

Format the text in the same way you did the Last Refresh Date cell.
The report now appears like this:

Quarterly Revenues for New York

LE t lime d@ument w.8 .efrcahrdi

01

o?

o3

84

$248,401

$230,808

$1 06,053

$1 94,036

$779,301

Fridi]r, Jmuary '13, 2006

1

2

3

4

5

7

I

o1

a2

a3

Q4

$261,295

$281,708

$1 83,899

$377 ,577

$1,1 04,278
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Displaying data restricted by a filter or ranki.g

@ Introduction
This unit describes how you can display certain data that is available in the
data provider but does not appear in the table because a report filter or ranking
function has been applied to hide some of the values returned by the query.

After completing this unit, you will be able to:
. Use the NoFilter0 function to override a report filter or ranking

.m

ffi

'@ Overriding a report filter
At times you might need to display a calculation that includes both the data that
is shown in the table and data that is present in the data provider, but not
currently shown in the table. The only way to achieve this is to force Web
Intelligence to ignore a report filter or ranking that has been applied to an
object or variable in the data provider.

NoFilter function
Use the NoFilter$ function to override a report filter or ranking. NoFilter$
includes all of the values for a variable in the data provider in the calculation,
even if the data is not displayed in the table or block.

Syntax:

NoFj I ter(AggregateFuncti on(measure) )

Scenario

Create a report that displays the top three stores per year. Section the report
by year. Calculate the revenue of the top three stores, the revenue of the
stores that did not make the top three, and the sum of all the stores combined.

To use the NoFilter) function
1 Create a new Web Intelligence document using the eFashion universe.

2 Build a query using the Year, Store name and Sales revenue objects.

3 Click Run Query.

4 Right-click the Year column and select Set as Section from the drop-
down menu.

5 Select the Sales revenue column, and then click the Apply/Remove
Ranking button on the Reporting toolbar.
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In the Rank dialog box, accept the default values to list only the top three
stores based on Sales revenue and click OK.

Apply a Sum to the Sales revenue column.
The table should now look like this:

2001

e-Fashion New York Magnolia

e-Fashion Los Angeles

e-Fash'on Chicag! 33rd

2002

$1,0?3,061

ss82,637

$737,91 4

$2,713,612

$1,687,35S

$'t,581 ,616

e-Fashion New York Magnolia

e-Fashion Los Angeles

I
10

11

Right-click the 2001 Sales revenue footer row and select lnsert row
below from the drop-down menu.

Click the new cell below the original sum to select it.

Click the ShodHide Formula Toolbar button on the Reporting toolbar.

Type directly in the Formula bar, or open the Formula Editor, and create
a formula that will calculate the sum of Sales revenue for the stores that
are not part of the top three.

=NoFi l ter( Sum( [Sal es revenue] ) ) -Sum( [Sal es revenue] )

The Formula Editor appears like this:

,,i:*@
::'1
:.l
ut
., 

1

:.i
:lrl

r1

::j

:::j

::,

l;#,*;* ' -

: $aLileverue t .g t""*n*"i SfU rUO

j u-'

:,S. Hpn,

BK I cancat I H-b I
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By dissecting this formula, you can see how the formula will return the
desired result.

12 Click Validate to check your syntax, and then click OK to close the
Formula Editor.
At this point, your report should look like this example:

2001

*Fashion NewYolk Magnolia

e-Fashion Los Angeles

*Fashion Chicago 33rd

20g.2

t1.023.06.|

s982,6:7

t737.91 4

$2,713.81 2

+Fashion NewYork Magnolia

eFashion Los Angele9

*Fashion Wa-shington Tolboolh

Sum

2003

Edit the text in the cells to the left of the
is immediately meaningful.

calculated sums. so that the data

$1,6S7.359

$1 5S1,61 6

$1,21 5,1 5€

$4,494,1 33

8,748,1 I ? 9

13

2001

e-Fashion NewYork Maqnolia $1,023,061

e-Fashion Los Angeles $982,637

€-Fashion Chicago 33rd $737,91 4

Sum ofTop Three: $?,743,61 2

Sum ofolherSlorcs 53522n2

2002

+Fashion NNYorkHagnotia $1,687,35S

e'Fashion LosAngeles $'i,581,616

e-FashiEn Waehrngton T0lboolh $1,21 5,1 58

Sum ofTop Three: $4,184,1 33

SumolotherStores 8,748,112S

2003

The next and final steo is to calculate the sum of

Advanced Reporting Techniques-Learner's Guide

Formula component: Syntax and description:

=NoFilter(Sum([Sales
nevenuel ) )

NoFi I ter(Aggregate( [Measure] ) )

This returns the entire sum of all the stores
and ignores rank.

-Sum( [Sal es revenue] ) This pad of the formula returns the sum of
the stores in the current block (with the
rank). lt does not include the stores that
are missing.

all the stores.
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14 Insert another row at the bottom of the table.

15 Highlight the cell below the other sum cells and using the Formula
toolbar or the Formula Editor, type this formula:

=NoFi I ter( Sum( [Sal es revenue] ) )

The finished report should look like this example:

+Fashirn NewYork ldagnllia ' $1,0?3,061

eFashion Los Angeles , tgge,Ogf

e-Fashion Chicago 33rd $737,9 1 4

Sum ofTop Three:, $2,743,61 ?

Sum ofOther Stores $5,352,202

Sum ofAll Other Stores:: $e,095,S1 4

2002

ffi

2001

e-Fashion New York Magnolia

F-Frehinn I nq Andolca

$1 ,687,359

sl 5Rl 616

Note: The results shown in this example are truncated.

The formula calculates the following data:

=NoFilter(Sum([Sales revenue]))
Sum([Sales revenue])

Result

$8,095,81 4 - $2,7 43,612 = $5,352,202

16 Save the document in your Favorites folder as Doc-NoFilter.
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W Practice

Activity: Displaying document information in a

report

Objectives
. Build a formula using the UserResponseO function to capture the user's

response to a prompt and display it in the title cell.
. Display the date and time the document was last refreshed.

Instructions
1 Use the eFashion universe to create the report shown below.

2 Build the report so that it prompts the user to select a year and a product
line.

3 Format the title cell so that it displays the chosen value when the
document is refreshed.
The report should look like this:

2001 Annual repoft for Leather

e-Fashion Austin

e-Fashion Boslon Newbury

e-Fashion ChicagD 33rd

e-Fashion Colorado Springs

e-Fashion Dallas

e-Fashion Houston

e-Fashion Houston Leighton

e-Fashion Los Angeles

e-Fashion Miami 9undance

e-Fashion New York sth

e-F?shion New York Magnolia

e-Fashion San FranciscI

e-Fashion Washington Tolbooth

s2,71 3

$81 1

$3,903

$2,1 35

$1 ,1 85

$2,052

$24,031

$1,5S6

$2,837

$5,57S

$2,881

$1,35S

't5

5

12

26

't1

I
10

163

I
14

30

16

7

$1,301

6272

$980

$1,57S

$1 ,113

$488

fi1,177

s9,234

$848

$1,501

$?,530

$1,258

$708

Date was last refreshed on:1J13O5 4:35 PM

4 Save the document to your Favorites folder as Act_Documentdisplay.
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Lesson summary

ffi Review

Quiz: Advanced Reporting Techniques
1 When you apply a standard calculation such as a Sum or an Average on

a column in a table with a break, where is the calculation inserted?

1 ln a data cell

2 In the break footer

3 In the section

4 In the break header

2 In the Java Report Panel, how do you format a break?

3 How do you set the break priority when there are multiple breaks applied
to a table?

4 What function can you use to capture the response to a prompted query
filter?

5 What function can you use to override a report filter or a ranking?
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@ summary
After completing this lesson, you are now able to:
. Manipulate break headers and footers to change the display of the data
. Prioritize multiple breaks in a trable
. Use breaks to format crosstabs
. Explain the default sort orders available in Web Intelligence
. Create a custom sort
. Apply a custom sort to a column of data
. Delete a custom sort
. Display the user's response to a prompt in a title cell
. Display the date that the document was last refreshed
. Use the NoFilter$ function to override a report filter or ranking
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Lesson 5

Calculation Gontexts

This lesson provides information on how Web Intelligence performs calculations
in reports. By default, Web Intelligence determines the result of a measure when

it is projected in the report based on the dimension(s) in the part of the report
where the measure is inserted (for example, in columns of a table). These

dimensions make up what is called the calculation context of the measure object
or variable.

Understanding how contexts behave by default is key to understanding how to
manipulate the context so that, in certain circumstances, the report displays the

data you are interested in.

This lesson demonstrates how to use various operators and keywords to define
and redefine contexts in your calculations.

In this lesson you will learn about:
. Understandingcalculationcontexts
. Redefining calculation contexts

Duration: t hour 30 minutes

Copyright @ 2006 Business Obiects. All rights reserved. 5-1



Understanding calculation contexts

ffi Introduction
This unit introduces key concepts of calculation contexts in Web Intelligence.
Calculation context is the way that Web Intelligence dynamically calculates
values projected in a report by measure objects or variables.

ln a Web Intelligence document, measures are calculated dynamically based
on the dimensions with which they appear. For this reason, it is important to

understand that Web Intelligence, by default, performs calculations at the row

level.

After completing this unit, you will be able to:

. Explain how Web Intelligence calculates data dynamically

. Explain the impact of input and output contexts on how data is calculated

. Explain how you can use extended syntax to change the default
calculation context

€ Dynamic calculations

By default, Web lntelligence dynamically calculates and displays measures
based on the dimension that appears in the block with the measure.

ry ffi*reffiCa'ifofnia 2001 $1,70d,21 I edfil.t
catjfofnia 2002 t?,7g2,680: :California $7.47S.56S

Calitornia 2003 S2.93?,6?9, 'Colorado $2,060,275

colorado 2001 $148,302 DC 52,961,950

Colorado 20n? $768,390: :Ftorida $1,879,153

.r,orado l00l $841,584 iltrnois $J,022 969

Dc 2001 $693'21 1 ,htassachuEets $1 ,283.707
Bc 2oo2 $1':15'158 NewYork $7,88?,?:1
Dc 2003 s1,053,se1 Teras $.1 0,1 i t,661
Florida 20!1 $105,985,

Floilda 2002 $661.250

Floiloa l00l $811,914

lllinois 2001 $73s.221,

lllinois 2AA2 $1 ,1 50,65s

r,ilnois 2001 $t,t f+.OeS

h4assa(husetls 7001 |s]18.819

Massachusetts 2002 $1 5?.71 s

Masga(huccfls l00J legz.rts

{ewYo'k 20Dl $,6b7,6S8

NewYork ?002 $2,763.501

\edY! k ?001 $1,151,0:l

Teras 2001 $1,1 99.6?7

Texae ?002 $:.73?,889,

Teras 2001 $4,1 85.098

ln the first table above, Sales revenue is aggregated in the context of State and
Year. When you remove a dimension from the table, as in the second table
above, Web Intelligence automatically recalculates the sales revenue data
according to the new context (State, in this case).

In this example, sales revenue has been calculated at the row level, This row

level calculation is the default calculation context for any measure object or
variable placed in a column.
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Although this default calculation context is usually sufficient, there are times
when you need the measure to calculate at a level other than the default
context.

It is possible to change the default context of a measure by modifying the
syntax of the variable to include a specific input and/or output context for the
calculation.

l&W Input and output contexts

Input and output contexts must be added to a calculation if you want the
context of the calculation to be something other than the default context.
. Input context consists of any dimension objects that need to be included

directly lN the calculation itself.

. Output context consists of one or more dimension objects that determine
where the calculation is placed in the repoft, or in other words, the level
where the calculation is to be turned OUT in the report.

In fact, the output context determines at what aggregation level the
calculation is displayed (for example, a master variable in a section).

ln the simole calculation shown here:

= Sum( [Sal es nevenue] )

there are no dimension objects in the calculation itself, so the input context is

the sum of the values returned by the measure object Sales revenue. This
calculation does not specify an output context, so Web Intelligence assumes
the default context and uses the dimensions with which the measure appears.

ffiffitw
celifornia $I,47S,560

cololado $2,060,275

DC S2,961,950

Florida $1,879,159

iltinois $3,02?r9os

Massachusetts $1,283,707

NewYolk S7,582,221

Texas $1 0.1 1 7,664

Sum: $36,387 51 2

As no output context is specified for the Sum calculation, it assumes the
context of State.

The syntax for defining the input and output conlexts is:

AggregareFx( ll'4easurel i npuL_context) outpuL-c0nLext
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& Understanding when to redefine the context
The following example demonstrates how to extend the syntax of a formula in
order to redefine the output context that will be used to calculate the measure.

To reilefine the output context using extended syntax
1 Create a new Web Intelligence document using the eFashion universe.

2 ln the Java Report Panel, build a query by dragging or double-clicking the
State, Year and Sales revenue obiects to move them into the Result
Objects pane.

3 Click Run Query.

4 ln Edit Report view, select the State column to highlight it.

5 Click the InserURemove Break button on the Reporting toolbar to break
the table into separate blocks.

6 Click the Sales revenue column and click the Insert Sum button on the
Reporting toolbar.

7 Verify that the Sales revenue column is still selected, and then click the
Apply/Remove Sort button on the Reporting toolbar and select
Descending.
The report now appears as shown below:

California

California

2003

2002

2041

$2,9921679

$2,782,680

$l ,704,21 1

$7,479,569

c0l0rad0 2003 $843,584

2002 $768,330

200'1 $448,302

Colorad0 Sum $2,060,275

wwffi
2002 51.21 5.1 58

The Sales revenue measure is currently calculated to show each state's
total sales revenue per year. You can easily see each state's best year
amount as you view the rows in the block. The break footer displays the
total revenue earned for all three Vears.

5-4 Advanced Report Design-Learner's Guide



Create a new table in this report by dragging and dropping the State and

Sales revenue objects just to the right of this block.

Note: To select more than one object at a time, click the first object, hold
down the Ctrl key and click another object. Continue holding down
the Ctrl key and drag both objects at the same time to a position

next to the existing block.

The report now appears as shown below:

W
California

carifor;ia

2003

2002

2001

$2:9_s?,9le callfolniS

$2,782,680 colorado

fi 
.1 :7D1.:?]1. DC

$7,479,569 Ftorida

$843,584 NewYofk

$768f390 Texas

$448,302

$2,060,275

$7,479,569

$2:060,275

$2,981,9 0

$1,87911 59

I3,022lSEe

$1,283:707

$7,582,221

$1 0,1 1 7,664

lllinois

Massachusetls

DC 2fr02

2003

']fin1

In this new table, you can see each state's overall sales revenue, without
either the revenue per year or the state's best year amount. The sales
revenue data has been aggregated to the state level.

Create a new variable called State's best year amount.
Use the following formula in the variable definition:

=max( [Sal es revenue] )

Note: Qualify the variable as a measure and be sure to validate your
syntax before closing the Variable Editor,

$1 2151158

$1 059,,581

$ffq3 ?1 1
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10 Drag and drop the new variable so that the data is projected in a new
column to the right of the Sales revenue, in the second block.

The report now appears like this:

Califtrrnia

C alif! rnia

$2,S92,679

$?,782,68r1

$1,704,?1 I

$7,478,56S

Califernia

C ol ofa do

DC

F lorida

illinoie

M€ssaIhusBtls

NEwYork

Texas

Califofira

Colorado

DC

Florida

llti nois

lil9ssacf usetts

NEsr YDrk

Texas

:003

2BO2

?00'l

$7,4i9,56! $7,47S.563

$:,060,2?5 $2,060,?75

$?,s61,950 5?.S61 ,950

$1 ,87!,r 5! $1 ,A7!,1 5S

s3,022,968 $3,012,388

$1 ,283,707 $1,?83,107

$7,58_2,221 $7,58?,221

$1 0,1 1 7,664 $1 0,.l 1 7,ts84

$7,47S 569 $?,9S?,670

$2,060:?i $e43,584

$?,sEl 950 sl ,?1 5,1 58

$1,879,1 59 $81 1,S?4

$3,0?2 SEE $ 1 ,1 50,85u

$1,283,707 $8S7,1 6S

$7,581,211 $3,1 51,0?l

$1 0,1 1 i 684 $4,1 E5 0S|]

C!lDrado

Colorado

2003

2082

2D0 l

$843,584

s768,390

$44e,31?

$2,06[,275

:DC '20n2 $1,21 5,1 58

2003 $1,053,581

?nnl qaar f i

lf you compare the state's best year revenue shown in the first block with
the data calculated by the variable you just created, you can see that the

default behavior of the calculation, at the row level, is obviously not the

correct context.

By default, Web Intelligence does not know that the Year object needs to
be included in the context of the calculation - it is simply using State as

the input context in order to calculate the values, and the result is the
exact same calculation that the Sales revenue object projects.

Now you are going to extend the syntax in order to specify the correct
input and output context so that Web Intelligence knows which context to

use to calculate the data correctly.

11 Modify the variable definition to specify the input and output context,
using this formula:

=p6x([Sales revenue] In([Year] ; IState])) 1n ([State])

Compare the total sales revenue for all three years shown in the first
block, with the data in the Sales revenue column in the second block.

Web lntelligence now calculates the data correctly, because it calculates
the maximum amount of Sales revenue for each State in any one Year.

Califernie

CallfDrnla

t003

2tt1

?001

$? ss2 Etg

$2 782 680

$ 1 ,7[4,?1 1

$7,47S,588

aolorado

CBlorado

$843,5S4

$768 39tl

$448 30?

$1 0s0 ?75

2003

20!-l

2001

WW
DC 200?

10D:l

?801

12 Save the document in your Favorites folder as Doc-Bestyear.

$1,t15lttl

$1,013,581

$6S3.11 1
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Components of the input and output contexts

In order to understand input and output contexts, let's review the following
components of the calculation:

=max( [Sal es revenue] In( [Year] ; IState] ) ) In ( [State] )

Note: This example is given for demonstration purposes. lt is not always
necessary to define the output context, since Web Intelligence
assumes this context based on the olacement of the formula in the
report. As a rule of thumb, context should be left as the default
(undefined), unless it must be defined in order to achieve a certain
result. This allows variables to be reused in other oarts of the reoort.

The operator In is a generic operator that allows you to define the parameters
of either input or output contexts.

Component Description

In( [Year] ; IState] ) This component is considered the input con-
text since the variable needs to consider both
the State object and the Year object (which is
not in the table) when making the calculation.

Notice that the entire input context appears in
the same parentheses as the measure object.

Note: Web lntelligence uses In Body if
there are no dimensions in the input
context by default.

In ( [Slate] ) This component is considered the output
context since it is necessary for the calcula-
tion to aggregate at both the State and Year
levels (outlined in the input context), but dis-
play at the State level only.

The output context is always placed outside
the parentheses containing the measure
object.
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About the extended syntax operators and
keywords

The extended syntax that is available to redefine the calculation context of
measures includes:
. Extended syntax context operators, including In, ForEach, ForAll
. Extended syntax keywords, including Report, Section, Break, Block and

Body. These keywords are used in formulas in conjunction with the In
context operator.

The operators and keywords you can use to define input and output contexts
are located in the Operators tab in the Variable Editor:

111im
:::.] B etween

:iaiElock
:::1:b0dy

$jeoto'
:::lBEik

:riJCol

=Diltimt
:::lr"'nrr
lilr"n*n
'1"-

::r:JlnList
allN ftl

::!or
tlilh ePorl

illlFow
.::lSeclior

seit

:::ir.p

:.1.Y.!:":_-_
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Redefining calculation contexts

@ Introduction

This unit provides examples of reasons why you might choose to redefine the
input or output contexts of measures in your report.

These examples show how to use both extended syntax context operators and
keywords.

After completing this unit, you will be able to:
. Use the In context operator to redefine calculation context
. Use the In context operator with Where to redefine calculation context
. Use the ForEach context operator to redefine calculation context
. Use the ForAll context operator to redefine calculation context
. Use the Block keyword with In to redefine calculation context

#ih
WP Using extended syntax context operators

The context operators that are available to redefine the calculation context of
measures include:

Operator Definition

ln Used to specify dimensions explicitly. Also used with
extended syntax keywords.

Where Specifies limiting conditions on the data

ForEach Adds dimensions to the context

ForAll Removes dimensions from the context

The ForAll and ForEach operators are useful when you have a default context
with many dimensions. lt is often easier to "add" or "subtract" from the context
using ForAll and ForEach than it is to specify the list explicitly using In.
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In context operator
The In context operator is used to specify dimensions explicitly in a context.

Syntax:

in([djmension] ; Idimension])

Scenario

You have a report showing Year and Sales Revenue. The Quarter object is
also available in the data provider but you do not include this dimension in the
block. Instead, you want to include an additional column to show the maximum
revenue by quarter in each year.

To use the ln context operator
1 Create a new Web Intelligence document using the eFashion universe.

2 In the Java Report Panel, add the Year, Quarter, State, and Sales
revenue objects to the query.

3 Click Run Query.

4 In Edit Report view, remove the Quarter and the State objects from the
table.
The table should look like this:

W
?001 9e,0s8,1 2{

:00? $1 3,232,?46

200r $1 5,05s,1 43

5 Hold down the Ctrl key and drag the table to the right to make a
duplicate copy.

6 ln the copied table, drag the Quarter object and insert it in a column
between the Year and Sales revenue columns.

7 Apply a break on the Year column.

8 Click the Sales revenue column to hiqhliqht it.
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Click the drop-down arrow next to the Insert Sum button on the Report

toolbar and select Max

The reoort should look like this:

W
2001

2002

2003 $1 5,059,1 43

$Er0g.q,r ?1 2001

s'13,23?,246

G1

Q2

cr4

$2 660 700

$2,279,0r13

s1,36r1841

$1 !799r580
$?,660,700

cl
o2

G3

Q4

$3,3?6 1 72

$2:e4o 651

$2,878,303

$4,'l 86,120

$4,1 S6,1 20

o1 $3,742,98S

10

11

In the second table, because Quarter is in the block, the default
calculation context automatically displays the maximum quarterly

revenue in the footer.

You want to display the same values in the first table, without having to
include the Quarter object in the table.

Create a Max Quarterly Revenue variable using this formula:

=Max([Sales revenue] In([Year] ; IQuarter])) In([Year])

Drag the new variable to the right of the Sales revenue column in the

originaltable.
The original table looks like this:

?!q1
?002

2003

$8,0s6,1 24

$1 3,:3?,246

$15,05S,'i43

$2,860,700

$4,1 AE,1 ?0

$4,006,r1 I

This formula tells Web Intelligence to calculate the maximum sales

revenue for each (Year, Quarter) combination, and then output this figure

by year.

Note: Because the default output context of the block is Year, you do not

need to specify the output context explicitly in this formula.

Save the document to your Favorites {older as Doc-Contextoperators.12
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In context operator with Where
Two of the most widely-used operators used to specify both input and output
contexts are In and Where. Although each operator denotes a different type of
calculation environment, the two may be used together in a single variable.

The In operator specifies all parameters (dimension objects) that should be
included in the context. When using multiple dimension objects, the
dimensions should be listed in order of granularity and should be separated
with ";".

The Where operator instructs the variable to calculate only where certain
values are true.

Scenario

Produce a repon that calculates both the highest Sales revenue for all states
as well as specific information for California.

To use the In and Where context operators
1 Continue working with the Doc_Contextoperators document.

2 Right-click the Report 1 report tab and select Insert Report from the
drop-down menu.

3 In the new report, press the Ctrl key and drag the Year and Sales
revenue objects to create a new vertical table.
The table should look like the followino:

2081 $8,096,1 ?4

2002 $1 3,232.246

2003 $1 5,059,143

4 Create a Sales revenue By Year for California variable with following
input context:

=lSaI es nevenuel Where ( [State]='Cal I forni a" )

This context uses the Where oDerator to isolate the California state in the
calculation.

5 Replace the Sales revenue object in the table with the new variable.

Note: Use the Properties tab to format the column in the table:
. Set the text in the column header cell to Wrap
. Display the data as $ amounts.

Your report should now look like this example:

2001

1002

2003

$1 ,704,?1 0.80

$?,782,6rS.50

$?,sg?,679.00

Create the Sales revenue for all States calculation by dragging and
dropping the Sales revenue object from the Data tab and dropping it
outside the table anywhere in the report space.

Insert a free-standing cell to the left of this calculation and enter text that
identifies the calculation.
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10

Create the Highest Sale Revenue for any one State variable using this
syntax:

=l',lax( [Sa les revenue] In( [State] ))

This context uses the In operator to specify input context. This assures
that the calculation only addresses the State values when locating a
maximum amount.

There is no output context defined, so the calculation uses the default
output context of the entire report, because it was placed at the report
level rather than in a table.

Drag the new variable in the report space and insert a free-standing cell
with text that identifies the calculation.

Create the Highest Annual Revenue for California variable using the
following syntax:

==lulax([Sales revenue] In(lStatel ; IYean] ) l,lhere([State]
="Califonnia"))
This variable definition uses both the In and Where operators to achieve
the correct calculation. Both operators were used in defining the input
context.
. The In operator forces the =Max function to look in the State values

first and then the Year values within each State in order to locate the
maximum value.

. The Where operator assures that the =Max calculation is only valid
where the State is California.

Create the Sales revenue for California for 2003 variable using this
synlax:

=[Sales revenue] ldhere([Stale]="California" And IYean]
= 2003" )

Like the Sales revenue By Year for California object, this calculation uses
the Where operator in the input context to ensure that the calculation is
valid for only those values denoted by the Where operators.

It is not necessary to list the components of the calculation in order of
granularity when using the Where operator. You must list the components
when using the In operator.

Insert this variable in the report and insert another free-standing cell with
text to identify the calculation.
Your completed report should look like this example:

Sales revenue for all slates: $36.387,512

Highesl sales revenue for any one State: $10,112,664

Hlshesl annual revenue for California: 2,992,679

Sales revenue for California for 2004: 2.99?.679

11

12

?0111

2QD')

?003

13 Save the document.

$1,704,21 rl.|]0

$i,78?,679 50

$?,99i,67S.00
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ForEach context operator
The ForEach context operator adds dimensions to a context.

Syntax:

ForIach( [dimension] )

Scenario

Create a report that calculates the maximum revenue by year and quarter in a

table, when the Quarter object is not shown in the table.

To use the ForEach context olterator
1 Continue working with the Doc-Contextoperators document'

1 Right-click the Report 2 report tab and select Inseft Report from the
drop-down menu.

2 In the new report, press the Ctrl key and drag the Year and Sales
revenue objects to create a new vertical table.

3 Create a Max Quarterly Revenue variable with the following input
context:

=1'43x([Sa1es revenue] ForEach([Quarter])) In(lYeanl)

4 lnsert the new variable in the table.
The table should look like the following:

:001 $8,096,1 ?4 521660,700

2002 $ 1 3,231,246 $4,1 86,1 20

lB03 $1 5,058,1 43 $4,006,11 I

The Year dimension is the default input context in the block' By using the
ForEach operator, you add the Quarter dimension to the context' giving

an input context of ([Year];[Quarter]).

5 Save the document.
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ForAll context operator
The ForAll context ooerator removes dimensions to a context.

Syntax:

ForAl I ( [di mensi on] )

Scenario

You have a report showing sales revenue per year and per quarter. You want
to add a column that shows the total revenue in each vear.

To use the ForAll context operator
1 Continue using the Doc_Contextoperators document.

1 Right-click the Report 3 report tab and select Insert Report from the
drop-down menu.

2 In the new report, press the Ctrl key and drag the Year, Quarter and
Sales revenue objects to create a new vertical table.

3 Click the Sales revenue column and apply a Sum.
The standard sum function inserts a footer in the table and displays the
total revenue for all quarters in the three years, using the default
calculation context.

2001

2r101

2001

20[1

2002

200?

?002

2B[2

2003

20!3

2003

2003

o?

o3

a4

0'1

cr?

a3

o4

0?

o4

-..,, : Q;],,,.f!

, -sl:??srlo]
$1,3€?,8.{1

- t1.?sa f8s

$3,3?6;1 r:i
:
'f2,848.S51

: ri:tg.!.St8r3ga

:J4;18S;1?B

$3J1t.e8B

:. S4,S06;11I

t.;; iry ,wr,

I $3i356-;n{1

Sum: $36.38L51 2

You want to display the total revenue for each year. To total revenues by
year, the input context needs to be (Year); by default, it is (Year; Quarter).
Therefore, you need to remove Quarter from the input context by
specifying ForAll ([Quarter]) in the formula, which tooks like this:

=5um( [Sal es revenue] ) ForAl I ( [Qua rter"] )

Note: Note that you can use the In operator to achieve the same thing.
Using In, the formula is:

=5um( lSal es Revenuel In ( [Year"] ) )

This version of the formula explicitly specifies Year as the context,
rather than removing Quafter to leave Year.
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4 Create a Yearly Total variable with the following input context:

=Sum( [Sal es revenue] ) ForAl I ( [0uanter] )

lnsert the new variable in the table.
The table should look like the following:

2991 "

2001

2gflJ ,
200 1

:of?
28fi2

?8fr-2,...,.

?001

;;;
.?09:* .

2Dg3

81

:e2
''':'-l

't:a' * -
j04

o1

:e?

,,u3 _
:44
:..,
iGl

a2

:44

. . : : . . $466P.79!: _ . - 
$-8j.r0..98r12.4

: sr,:is,go:: $8,096,124

',.-.:t ;,!lit;i' t *;,3loli;
: $1,7SS,5S0: {S,096,124

,' i .,- ;;;iu.rir, .s itru
: $2,840,651: $1 3,232,246

i $2,879,303' $',t 3,232.?46

I $4,186,120: $l 3,232,?46
- 

" 
' '' raz!:seg' 

'"- s'etia'a'
$4,006,71 B $1 5,05S,1 43

it.
, . I -. .--$3:951:.195;::::.. -$J5.:!59,]13:,i $3,356,041: $l 5,059,1 43

sum:, S36,387,512:

Note: Another way to show this calculation would be to apply a break on

the Year column and then apply a standard sum. You would then
get the yearly total in the break footer, and the overall total in the

block footer.

Save the document.
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ffiW Using extended syntax keywords
The extended syntax keywords, Report, Section, Break, Block and Body, are
also useful in defining calculation context. These keywords, used in
conjunction with the In operator, allow you to change the default context from
the row level to another level in the document.

ln this example, you will use the In Block keyword to change the calculation
context from the row level to the block (or table) level, in order to highlight
values with an alerter.

Scenario

Create a report that contains an alefter which highlights any store whose
revenue for the year 2003 is lower than the average revenue of all stores in
2003.

To calculate aaerages in a table and highlightbelow aoerage
results
1 Create a new Web Intelligence document using the eFashion universe.
2 ln the Java Report Panel, build a guery using the Store name and Sales

revenue objects.

3 Apply a query filter to restrict the data retrieved to the year 2003.

4 Click Run Query.

5 In Edit Report view, click the Sales revenue column to highlight it.

6 Click the drop-down arrow next to the lnsert Sum button on the
Reporting toolbar and select Average from the drop-down list.
The table appears like this:

e-Fashion Auslin $1,1 35,479

e-Fashion Boston Newbury $887,1 69

B-Fashion Chicaoo 33rd $1,1 34,085

e-Fashion Cotorado Springs $E43,SS4

e-Fashion Dallas $803,421

e-Fashion Houston sth $91 0,4b1

e-Fashion Houston Leighlon $1,335,747

e-Fashion Los Angeles $1,656,676

e-Fashion Miami gundance $81 1,S24

e-Fashion NewYorkMagnolia $1,S11,434

eFashion NewYorkSundance $1,t39,S87

e-Fashion San FranciscD $1,336,003

e-Fashion Washinqton Tolbooth $1,053,581

Averatle $1,1 58 3SE

Click the footer cell at the bottom of the Store name column to highlight
it, and then click the Properties tab.

Edit the text Average in the footer so that the cell clearly identifies the
calculation at the bottom of the table. Type Average Revenue for All
Stores;.
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10

Click the Average value in the footer at the bottom of the table to
highlight it.

Click the ShodHide Formula Toolbar on the Reporting toolbar.
Notice the formula that Web Intelliqence used to automaticallv calculate
the average:

=Average( [Sal es revenue] )

This calculation is generic; it has no input or output context specified. lt
returns a correct average of revenue earned by stores because no other
soecific context was defined. The calculation used the default context of
the table footer, which contains calculations based only on data that
resides in the block (the table, in this case).

Note: lJ a report filter is applied to the table, the default context in the
table footer calculates only the values retained by the filter.

Build a new variable called Average and use the same syntax used by
Web Intelligence to calculate the average revenue for all stores.

Drag this new variable and position it to the right of the Sales revenue
column.
The table now appears like this:

11

12

e-Fashirn Austin

e-Fashion Boston Newbury

e-Fashitn Chir;g0 33rd

e-Fashion Colorado SFrings

+F asnron uailar

e-Fasf,iBn Hous'ton 5th

FFashion Houston Leighlon

e-Fashion Los Angeles

lFashinn toligmi Sundance

e-Fashion Nea York Magnolia

e-Fashion New York Sundance

e-Fashion gan Francisco

eFashi0B Washington TolbDoth

Averaqe Revenue for All stores

$1,135,473 $1,1 35,4rS

$88r,1 6S $887,169

61,1 34,0€5: $1,1 34,085

$843,584 $843,584

teo:,1:t: $803,4?1

$sl 0.451, $St 0,451

$1,335.747 S1 ,335,747

$1,656,618 $1,656,676

$81 1,S?4 $S1 1,924

$1.S1 1 ,434 $1 ,S1 1,4:4

$1,?3S,587 fi,:3S,547

$1,336,003 $1 ,336,003

$ 1,953,581 $1,853,5S1

$1,1 58,396

The Average variable appears in the table, but the values are now being
calculated at the row level rather than at the whole table level.

Why is this happening? The default calculation context has changed.

When the formula =Average ([Sal es revenue] ) is placed in:

. the footer: the context is to calculate for the entire table

. the table: the context is to calculate for each individual row

lf you try to build an alerter to highlight values in the Sales revenue column that
are below the average, the alerter will not work since the Sales revenue values
are currently equal to the average values.
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To redefine the calculation context using ln Block
1 Double-click the Average variable in the Data tab.

2 In the Variable Editor dialog box, modify the Average formula by

extending the syntax like this:

=Average( [Sal es revenue] ) In Bl ock

Why use this syntax?

By adding In Block as the output context, you are specifying that the
calculation should be displayed at the block (whole table) level, even though
the calculation was placed at the row level.

Why is there no input context?

No input context is needed since the calculation needs to find the average
based on the entire table. By leaving the input context to assume the default,
you assure that no additional objects are considered when the average is
calculated.

Now that the Average variable uses the correct formula, you can create the
alerter to highlight below average results per store.

To build an alerter to highlight below aaerage results
1 In Edit Report view, click the Alerters button on the Reporting toolbar.

The Alerters dialog box appears.

Cladte. edit, deHe. achvate ot destiv€te dltrtfl$.
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4

5

6

ln the Alerters dialog box, click New
The Alerter Editor dialog box appears.

fip'e*ata1 ";

lf # abmis ure, then dsday: - ceF :'vaert'

In the Alerter name field, type Below Average.

ln the Sub-Alerter zone, click the square option box just to the right of

the Filtered obiect or cellfield,
The Available Objects and Variables dialog box appears.

Click Sales revenue and click OK.

In the Alerter Editor, click the Operators drop down list arrow, then select

the Less than or Equal to oPerator.

click the Expand box just to the right of the operands field to select an

object to compare to.

The Available Objects and Variables dialog box appears.

In the Available Objects and Variables dialog box, select the Average
variable.

Click OK to create the alerter and close the Alerter Editor.

The Alerters dialog box appears again. Note that the alerter you just

created is listed now in the Available Alerters list'

Cre€te, editj:delete, etivate ot derctHite dErtero.

'iy*;la!rie Atesl*tr

Iry, I Edi! I nrprat" { e*ou1 ;{

0K I . r!n"", 
,,,,,,,1 . .. 

Hu,o 
I

.+:+
J*J

-j
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Click OK to close the Alerters dialog box.

You have finished creating the alerter, but now you must apply it to the
appropriate column of data.

ln Edit Report view, click the Sales revenue column in the table to

highlight.

Click the Alerters button on the Reporting toolbar.

The Alerters dialog box appears again.

In the Alerters dialog box, verify that the check box next to the new
alerter is selected.
This option applies the alerter to the column or cell that is highlighted in

the block.

Oe€te:d, Me, €{iivde s dari'tNdt abrtsc

/,i+il*|lo itle*t+rr

iles I

,.:,
ee :I o*ca" I n;nw I

ir@ 
"i@

Click OK to close the Alerters dialog box.

The Sales revenue values that are lower than the average revenue for all

stores value are highlighted in red in the table.

Remove the Average column of the table as it is no longer necessary.

The table should appear like this:

e-Fashion Austin 'i::: 
=$ti+.,:::.?74

e-Fashi0n BoEton Newtruly ::; :L:. *,*,??.,7 .6*,

e-Fashionchirrago33rd t,.:i,l Xii
e-Fashion.jDt0rads Springs ::t, ; ri.irL,f 

i3A4,
e-Fashion DallaE 

:iri::,: 
;Ji$f3:ii:il

:,;; : :;_r*t *:l#ie-FashiDn HDuEton sth ':
E-Fashion Houston Leighton [1,335,741

e-Fashion Los Angeles

e-Fasfri0n luliami Bundante l:,, ,,si 1.834

e-Fashisn NewYork Magnolia $1,s1 1,434

E-Fashi0n f,iev(Yerk Sufrdante $1,23S,587

e-Fashi0n San Franrisro 
.,.*l l?*ll.O.a

e-Fashion Washington Tolbooth ::: !,1,{1{3 5t\
Averaqe Revenue for All gt0res: $,1 ,1 58,338

16 Save the document as Doc InBlock.

14

15
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More about the extended syntax ke;rwords
The following keywords can be used with the In operator to control how

measures are calculated at different levels within the document: Report,

Section, Break, Block and Body.

Environment
Level

Effect

Report The projected value of the measure is aggregated for all

dimensions contained within the page of the report.

Section The projected value of the measure is aggregated for all

dimensions contained within the section of the report.

Break The projected value of the measure is aggregated for all

dimensions contained within the break of the table.

Block The projected value of the measure is aggregated across all

values for dimensions contained within the block.

Body The projected value of the measure is aggregated for all

dimensions at the level in the report that it is placed.

W Important facts about calculation contexts

lf you do not define an input or output context, Web Intelligence assumes
the default context of where the calculation has been placed.

When using variables as the basis of an alerter (as in the Average
example just seen), it is necessary to ensure that the calculation has

been created as a variable (that is, a formula with a name), and not as a

simple formula.

Note: lf the calculation is a formula, show the Formula toolbar and click
the Variable Editor button in order to name it as a variable'

When using the Where operator, it is necessary to place parentheses

around the values listed after the Where, as in the following example:

=[Sa1 es revenue] |,lhere ( lYearl = "200I" )
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W Practice

Activitv: Calculation contexts

Objective
Use extended syntax to redefine a calculation context of measures in a Web
Intelligence document.

Instructions
1 Create a document that shows in a single block:

. Sales revenue for each eFashion store

. Total sales revenue for all stores

. Average revenue for all stores

. Average revenue for all product lines per store

. Highlight those stores whose revenue was above average revenue
for all stores

2 Change the name of the report to Revenue Information for all Stores.

3 Save the document as Act_Calculationcontext.rep.
Your document should look like this examole:

R;;;;J; fii;#iil i;iAii sl;;;

e Fashion AuBJin

e-Fashion BDStDn NewburyW
.e Fashlon Cololado Splinqs

e-Fashion Dalles

e-Fashion HoustBn

Sum:

Ave ra qe:

s?r6991673 $?1799,01 6

$J 2e3:197 $2,7ss,01 6

$3,022,858 $?,rSS101 6

$1,060.?75 $2,199,01 6

$ r ,s70,034 $2,7S9,01 6

$2,303,1 83 $2,7SS,01 6

$3:1 44 7?1 $?,7es rr1 6

$4,220,525 $2,79S,018

$1,87S,1 5S

$2,960,368

$4,621,854

$3,258,641

$3,s61,e5o

$36,387,203

$?.7SS,81 E

$?,7SS,01 6

$2 79S 0t 6

$2,7SS 0t 6

$?,79S,01 6

$2,7SS,01 6
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Lesson summary

Review

Quiz: Calculation Contexts
1 What is an input context?

2 What is an output context?

3 Which of the following is an extended syntax context operator?

1 NoFilter$

2 ForEach

3 In Block

4 Which of the following is an extended syntax keyword?

I NoFilterQ

2 ForEach

3 In Section

5-24 Advanced Report Design-Learner's Guide



W summary
After completing this lesson, you are now able to:
. Explain how Web Intelligence calculates data dynamically
. Explain the impact of input and output contexts on how data is calculated
. Explain how you can use extended syntax to change the default

calculation context
. Use the ln context operator to redefine calculation context
. Use the ln context operator with Where to redefine calculation context
. Use the ForEach context operator to redefine calculation context

. Use the ForAll context operator to redefine calculation context

. Use the Block keyword with ln to redefine calculation context
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Appendix A
Answer Key

This appendix contains the answers to the reviews and/or activities for the
applicable lessons.
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Lesson l"

Quiz: Advanced Query Techniques
1 What are the three types of query techniques used in this lesson?

Answer:
Combining, Sub-query, Duplicating a query to build another

2 lf you were to use the UNION operator to combine queries, what would
be the result?

Answer:
Any records would be returned. This is the equivalent of doing an OR
between query filters.

3 lf you were to use the INTERSECTION operator to combine queries,
what would be the result?

Answer:
Only records that matched ALL criteria would be returned. This is the
equivalent of doing an AND between query filters.

4 lf you were to use the MINUS operator to combine queries, what would
be the result?

Answer:
Records that matched one condition but not the other.

5 Give an example of why a query filier won't return data when a combined
query using the MINUS does?

Answer:
Web lntelligence will not return data that does not exist using a standard
query filter.

6 Can you do a sub-query and return exactly the same results as a
combined query?

Answer:
Depending on the query, yes.

7 Why would you choose to do a combined query rather than a sub-query?

Answer:
Combined queries tend to be faster at returning the data.
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Lesson 2

Quiz: Character and Date String Functions
1 Name at least three character string functions used in this lesson.

Answer:

Choice o{ Right$, Substr$, PosQ, ReplaceQ, Length0

2 To find the occurrence of a comma in an object's value, which function

would you use?

Answer:
pos0

3 What is the syntax for the Replace$ function?

Answer:

Replace([string] ; "old string" ; "new string")

4 What does concatenation mean?

Answer:

To join two or more items together in a string

5 Give an example of something concatenated.
Answer:

Lastname+ ", " + Firstname

6 What happens if you put text and a date together in a variable?

Answer:
You get an error.

7 How do you resolve this?
Answer:

Use the FormatDateO function to convert the date to a character, but also
tell it what "picture" to use for the date

8 Can you do calculations on a date?

Answer:

Yes
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Lesson 3

Quiz: Using If Logic
1 What is another term for the logic used by the lfQ function?

Answer:
lf...Then...Else logic

2 Which of the following are examples of why you might use the lfQ

function to group values in a variable:

1 To display categories of values

2 To combine values from two different objects of the same type

3 To show values aggregated at higher levels of detail

Answer:
1and3

3 True/False. You can use the lf$ function to define a variable so that a

different calculation is used depending on the value retrieved by the

object specified in the variable's formula.

Answer:
True
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Lesson 4

Quizz Advanced Reporting Techniques
1 When you apply a standard calculation such as a Sum or an Average on

a column in a table with a break, where is the calculation inserted?

1 In a data cell

2 In the break footer

3 In the section

4 In the break header

Answer:
(2)ln the break footer

2 ln the Java Report Panel, how do you format a break?

Answer:
Select the column with the break, go to the Breaks folder in the Properties
tab.

3 How do you set the break priority when there are multiple breaks applied
to a table?

Answer:
Right-click the table, select Edit Format and click the Break Priority setting
in the Properties tab.

4 What function can you use to capture the response to a prompted query
filter?

Answer:
UserResponse0.

5 What function can you use to override a report filter or a ranking?

Answer:
NoFilter0.
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Lesson 5

Quiz: Calculation Contexts
What is an input context?

Answer:
The input context is the list of dimensions that are included in the
calculation itself.

What is an output context?

Answer:
The output context is the dimension level in which the calculation is to be
displayed in the report. For example, the output context can be the
dimension displayed at the row level; the dimension displayed at the break
level, and so on.)

Which of the following is an extended syntax context operator?

1 NoFilter$

2 ForEach

3 In Block

Answer:
2) ForEach

NoFilterQ is a function. In Block is an extended syntax keyword.

Which of the following is an extended syntax keyword?

1 NoFilteo

2 ForEach

3 In Section

Answer:
1) ln Section
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What did you enjoy least about the course?

Comment on this training guidets completeness, accuracy, organization, usability, and readability.

How did you find out about the training class?

What changes, if any, would you like to recommend regarding this session?


